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1 Getting Started with Light-O-Rama

Welcome to Light-O-Rama

Light-O-Rama is a computerized lighting system designed to control elaborate or simple lighting
displays. The Light-O-Rama system can be applied to almost any lighting situation, from stand-alone
controllers to synchronizing hundreds of controllers.

This page gives a high-level oveniew of how to start controlling your lights using Light-O-Rama:

e Getting Help about Light-O-Rama

¢ Important Terms and Information
e Connecting the Lights Using Light-O-Rama Controllers

e Creating a Show

For more detailed information, please see Light-O-Rama Concepts and the Light-O-Rama Software
Package.

Experienced users may wish to see what's new in the latest version of Light-O-Rama.

Getting Help about Light-O-Rama
Other than this help file, there are several ways to get help about Light-O-Rama:
Frequently Asked Questions, quick start guides, training presentations, tutorials, demos, and user
guides can be found on the Support page of the Light-O-Rama website, along with phone, mail, and
email contact information.
Light-O-Rama users' forums can be found at the LOR Users Support Center.
The LOR Wiki is a user-created and edited repository of Light-O-Rama information. Please note

that the information contained in the LOR Wiki is not published by Light-O-Rama, and cannot
be considered official.

Important Terms and Information

Companion Unit

A companion unit is a Light-O-Rama controller that receives lighting commands from another
source - either a PC running Light-O-Rama software, or from another controller known as a director
unit.

Control Panel

The Light-O-Rama Control Panel is a program that can be used to manage the Light-O-Rama
system on your PC. The Control Panel runs in the system tray (where the PC's clock is displayed).
Light-O-Rama is made up of a number of different programs, and the Control Panel is a convenient
way of accessing them. The Control Panel must be running in order to control shows from your PC.

Daisy Chain

© 2017 Light-O-Rama, Inc.


http://www.lightorama.com/support.html
http://lightorama.com/
http://lightorama.mywowbb.com/
http://www.lorwiki.com/

Light-O-Rama v5.0.14

This is the term generally used to describe the manner in which Light-O-Rama light controllers are
connected. A wire goes from the source (a PC running Light-O-Rama software or a director unit) to
a companion unit. Another wire goes from that companion unit to another companion unit, and so
on, until all companion units are "chained" together.

Do not put "Y"s or forks in the data cable. Only connect the units in this daisy chain configuration.

Data Cable

Light-O-Rama controllers can be connected using both data cables and phone cables, but you must
know which type of cable it is (for the purposes of Light-O-Rama, a cable is considered a data
cable if its wires are connected straight through).

How do you know if it is a data cable? Well, most likely the only cable that you will see that is not a
data cable is a wire that is intended specifically for phones. If you go to your local hardware store
and purchase a phone extension cable, then that wire is not a data cable. The distinction between
data cables and phone cables is important, because the wires are swapped around. There are
selectors or jumpers on most Light-O-Rama controllers that allow you to specify which wire type you
are using.

Only the wire coming into a controller (from the previous controller or from a PC running Light-O-
Rama software) should be used to determine which selector setting to use. The wire leaving a
controller (if there is one) can be of any type, and has no bearing on which selector setting should
be used. For example, if a controller has a phone cable coming in from the previous controller, and
a data cable leaving to the next controller, the selector should be set for "phone cable"”.

Director Unit

A director unit is a Light-O-Rama controller that sends lighting commands to other controllers
(known as companion units). Controllers can run individually in standalone mode, but to
synchronize multiple controllers together, they must be directed either by a PC running Light-O-
Rama software, or by a director unit.

Standalone sequences may contain lighting commands for a number of different units. A director
unit is a unit that is running standalone - i.e. not connected to a PC - that contains lighting
commands for other units cabled to it (the companion units). The director unit can also control its
own lights, simultaneously.

There is no difference in the hardware of a director unit and a companion unit - the only difference is
the mode that they are in.

A PC running Light-O-Rama software can also be thought of as a director unit, in that it can send
lighting commands to Light-O-Rama controllers. There must be one and only one director unit (or
PC running Light-O-Rama software) on a daisy chained group of controllers.

Hardware Utility

The Light-O-Rama Hardware Utility is a program that can be used to set up and test the hardware
used to control lights, as well as download sequences to standalone controllers or director units.

Phone Cable
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Light-O-Rama controllers can be connected using either data cables or phone cables, but you
must know which type of cable you are using. See data cables for details.

Schedule

A schedule is a list of shows and the times at which those shows are to be played.

If the Light-O-Rama Control Panel is running on a PC, and its "Enable Schedule" option is turned on,
then the schedule will be monitored, and its shows will be started and stopped at the appropriate
times.

The Schedule Editor program is used to create and modify schedules.

Sequence
A sequence is a file that contains a set of lighting commands to be sent to Light-O-Rama
controllers. There are two types of sequences: musical sequences, which have an associated

music or video file that is to be played at the same time, and animation sequences, which do not.

Sequences can be grouped together into shows.

The Sequence Editor program is used to create and modify sequences.

Show
A show is a file that contains a number of sequences, and the order in which they should be played.
A schedule can be created to specify the times at which various shows should be played.
The Show Editor program is used to create and modify shows.

Standalone
A Light-O-Rama controller can be controlled by another controller (or a PC running Light-O-Rama
software), or it can control itself and/or other controllers, in standalone mode. A sequence,
created using the Sequence Editor, can be downloaded to a standalone controller using the
Hardware Utility. The controller can then be set up to run this sequence whenever it has power, or, if
the unit is a model with an internal clock, it can be instructed to run the sequence during a particular
time.
A standalone controller whose sequence contains lighting commands for other controllers will

transmit those commands to the other controllers. In this case, the controller is known as a director
unit.

Unit

A unit is another term for a Light-O-Rama controller. Each unit has a number of circuits, each of
which can be used to control lights independently of each other. Each unit is identified by a unit ID.

Unit ID
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Each unit has an identifier assigned to it, known as a unit ID. When a lighting command is sent to
a unit, all of the units that are daisy chained together can see that command. Howeer, the
command contains a unit ID; only the units having that unit ID will act upon that command.

For Light-O-Rama controllers, the unit ID is a two characters, each of which can have any of the
values 0,1, 2, 3,4,5,6,7,8,9, A,B,C, D, E, and F. For example, "01", "25", "37", "5C", "BD", or
"E2". However, not all possible combinations are allowed: "00" and "F1" through "FF" are
disallowed.

Controllers other than Light-O-Rama controllers use different formats for their unit IDs.

Connecting the Lights Using Light-O-Rama Controllers

To connect lights using Light-O-Rama controllers, take the following three steps:

1. Determine the serial port and hook up a controller.
2. Select a unit ID.

3. Test the lights.
Step 1. Determine the Serial Port and Hook Up a Controller

Insert an SC485 converter into your PC's DB9 serial connector which you plan on using for the Light-
O-Rama network. If you are using a USB/RS-232 conwerter, then make sure that it is properly
installed, and that the SC485 conwerter is connected. If you're not sure what all this is about, simply
try to find a connector on the back of your PC that has nine pins and which will accept the SC485
adaptor.

Using a cable, connect a Light-O-Rama controller to the SC485 adaptor. Make sure that the LOR
controller is powered on. The LED in the controller should be blinking.

Using the Light-O-Rama Control Panel, start the Hardware Utility program. In the Hardware Utility's
Setup Comm Port section, use the Auto Configure button. This will cause the Hardware Utility to
look for the attached controller and determine which comm port is being used.

Step 2. Select a Unit ID

If your controller has unit ID selection switches, you can select its ID by adjusting the selectors to
the desired ID. If your controller does not have these unit ID selection switches, then you will need
to set its unit ID by using the Hardware Utility:

To set the unit ID using the Hardware Utility, connect one and only one unit to the PC using the
SC485 adaptor and a cable. In the Set Unit IDs section, go to Set New Unit ID, select the ID that
you wish to use for the controller, and click the Set Unit ID button. This button will only work on
new units that have never been assigned a unit ID (to change the unit ID of a unit that already has
one assigned, use the Change Existing ID section instead).

TIP: Assign unit IDs sequentially, starting at 01. This will make maintenance of the units faster.

Step 3. Test the Lights

With the unit connected to the PC, attach lights and power the unit on. In the Hardware Utility, click
the Refresh button in the top center of the screen. After a short time, your unit should appear in the
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dropdown list to the right of the Refresh button. Select the unit, and you can then test the lights
using the various controls in the Test Unit's Operation section of the Hardware Utility.

TIP: Before clicking Refresh, set the Hardware Utility's Max Unit ID to as low a value as possible.
This is the maximum unit ID of controllers that you plan on using (you can always change it to a
higher value if you add more controllers later). Setting it to a low value makes the Hardware Utility
run faster (though it will not find any connected units with higher unit IDs).

Creating a Scheduled Lights Display
To create a lights display and hawe it run at certain times, take the following steps:

1. Make yOour seguences.
2. Make a show.

3. Make a schedule.
4. Turn on the Control Panel's "Enable Schedule".

Step 1. Make Your Sequences
Using the Sequence Editor, create the sequences that will be used in your show.

You can test how the lights will look for a sequence while in the Sequence Editor: Make sure
Control Lights is turned on in the Play Menu, and that you have assigned the channels in the
sequence to a controller that is hooked up to your PC. Then, click the play button (which is the
green arrow in the toolbar).

Step 2. Make a Show
A show is a collection of sequences. A show can be created using the Show Editor program.
Shows hawe seweral sections, each of which can have sequences:

e Background: Sequences listed in the "background" section will be played for the entire
duration of the show.

e Startup: Sequences listed in the "startup” section will be played when the show first begins.

e Animation and Musical: After the "startup” sequences have completed, sequences in both of
these sections will run, until it is time for the show to stop.

e Shutdown: When it is time for the show to stop, the "animation" and "musical" sequences
will stop running, and the sequences in the "shutdown" section will start. Only after the
"shutdown" sequences are finished will the show truly end.

In the Show Editor, you can add sequences to any of these sections by selecting the appropriate
section's tab, and hitting the big PLUS button.

After you have created your show, you should sawe it using the "Sawe" or "Sawve As" button. Assign
the show a meaningful name - this is the file name that you will be using in the next step.

Step 3. Make a Schedule

Unlike sequences, you cannot run a show interactively. Instead, to test a show, put that show into
a schedule, using the Schedule Editor program:
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2

In the Schedule Editor, click the Add button, and select the show file with the name that you
created in the previous step. Select a start and end time that will allow the show to start at a

conwvenient time for you to view it. Then click Save to save your schedule.

Step 4. Turn On the Control Panel's "Enable Schedule"

To view the scheduled show, turn on the "Enable Schedule" option in the Light-O-Rama Control
Panel. Doing this will cause the Control Panel to monitor your schedule, and start and stop your

show at the appropriate times.

What's New?

What's New in Light-O-Rama

What's New in Version 4.3.20
What's New in Version 4.3.18
What's New in Version 4.3.16
What's New in Version 4.3.14
What's New in Version 4.3.12
What's New in Version 4.3.10
What's New in Version 4.3.8
What's New in Version 4.3.6
What's New in Version 4.3.4
What's New in Version 4.3.2
What's New in Version 4.3.0
What's New in Version 4.2.10
What's New in Version 4.2.8
What's New in Version 4.2.6
What's New in Version 4.2.4
What's New in Version 4.2.2
What's New in Version 4.2.0
What's New in Version 4.1.2
What's New in Version 4.1.0
What's New in Version 4.0.38
What's New in Version 4.0.36
What's New in Version 4.0.34
What's New in Version 4.0.32
What's New in Version 4.0.30
What's New in Version 4.0.28
What's New in Version 4.0.26
What's New in Version 4.0.24
What's New in Version 4.0.22
What's New in Version 4.0.20
What's New in Version 4.0.18
What's New in Version 4.0.16
What's New in Version 4.0.14
What's New in Version 4.0.12
What's New in Version 4.0.10
What's New in Version 4.0.8
What's New in Version 4.0.6
What's New in Version 4.0.4

© 2017 Light-O-Rama, Inc.



What's New?

e What's New in Version 4.0.2
e What's New in Version 4.0.0
e What's New in Version 3.12.2
e What's New in Version 3.12.0
e What's New in Version 3.11.2
e What's New in Version 3.11.0
e What's New in Version 3.10.14
e What's New in Version 3.10.12
e What's New in Version 3.10.10
e What's New in Version 3.10.8
e What's New in Version 3.10.6
e What's New in Version 3.10.4
e What's New in Version 3.10.2
e What's New in Version 3.10.0
e What's New in Version 3.9.0
e What's New in Version 3.8.0
e What's New in Version 3.7.0
e What's New in Version 3.6.0
e What's New in Version 3.5.0
e What's New in Version 3.4.0
e What's New in Version 3.3.0
e What's New in Version 3.2.4
e What's New in Version 3.2.0
e What's New in Version 3.1.4
e What's New in Version 3.1.2
e What's New in Version 3.1.0
e What's New in Version 3.0.2
e What's New in Version 3.0.0
e What's New in Version 2.9.4
e What's New in Version 2.8.12
e What's New in Version 2.8.10
e What's New in Version 2.8.8
e What's New in Version 2.8.6
e What's New in Version 2.7.6
e What's New in Version 2.7.4
e What's New in Version 2.6.2
e What's New in Version 2.6.0
e What's New in Version 2.5.6
e What's New in Version 2.5.4
e What's New in Version 2.5.2
e What's New in Version 2.4.10
e What's New in Version 2.4.8
e What's New in Version 2.3.8
e What's New in Version 2.3.6
e What's New in Version 2.3.4
e What's New in Version 2.1.6
e What's New in Version 2.1.4
e What's New in Version 2.1.2
e What's New in Version 2.0.16
e What's New in Version 2.0.14
e What's New in Version 2.0.12
e What's New in Version 2.0.8
e What's New in Version 2.0.4
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e What's New in Version 2.0.0
e What's New in Version 1.5.0
e What's New in Version 1.4.0

What's New in Version 4.3.20

¢ Improved Hardware Utility testing of Pixie and Cosmic Color Devices
e Support for new PixConl6 Firmware version 1.4.13
e Bug Fixes

Improved Hardware Utility testing of Pixie and Cosmic Color Devices

The Hardware Utility has been updated to allow for more intuitive testing of Pixie and Cosmic Color
Devices.

Support for new PixConl6 Firmware, version 1.4.13

Firmware 1.4.13 of the PixCon board has been released. There are no new features - this is only a
maintenance release.

Bug Fixes

¢ In some cases if a board that was not in the DeviceFile was searched for in the Hardware Utility,
the hardware utility could incorrectly log debug information as if the device were a Pixie board.
This did not affect the end user, but should not have been occurring.

¢ In Pixel Editor the OpenGL version on certain computers was not being detected correctly, leading
to a race condition.

What's New in Version 4.3.18

e New Enhanced File Processing for G3 MP3 directors
e New Firmware for G3 MP3 Directors

e Bug Fixes

New Enhanced File Processing for G3 MP3 directors
A new File Format is now created when writing an SD card with the Hardware Utility when a Network
contains Enhanced Light O Rama commands. This new file format improves the performance of the
MP3 director when using high speed (500K, 1000K) networks. To take advantage of this
performance enhancement, you must re-create your SD card using the Hardware Utility, as well as
update your MP3 director to the latest firmware.

New Firmware for G3 MP3 Directors
New firmware for G3 MP3 directors has been released to support the New Enhanced File processing
abowe. This firmware also corrects a bug that would sometimes cause a PixConl16 running at 1000K
to misfire/not connect.

Bug Fixes

e When writing an SD card with the Hardware Utility, in some rare cases where the first sequence
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only had REGular LOR commands and a non-G3MP3 director was selected, a blank Enhanced
file could be written to the SD card instead of regular commands.

¢ In Superstar, when importing a Msualization that forced a fixture to column 64 an error was
incorrectly reported. This error should occur only if the column if 65 or greater.

¢ In the Hardware Utility, the 'Channel Mode' for Cosmic Color Ribbons was being incorrectly set.

¢ In the Sequence Editor, if the user added a Pixie Device with Insert Device, in many cases the
Unit IDs of the created channels were not incremented properly.

¢ In the Hardware Utility, the progress bar when writing an SD card was not correctly reflecting
actual progress.

What's New in Version 4.3.16

Hardware Support for Pixie Controllers

Hardware Support for New 4 port MP3 Director

¢ Insert Pixie Device in Sequence Editor

New SD Card Wizard for writing MP3 Director SD cards in Hardware Utility
e Bug Fixes

Hardware Support for Pixie Controllers

Hardware Utility support for Pixiel6, Pixie 8, and Pixie 4 controllers has been added. You can now
configure these devices for use. Please note that the Sequence Editor has not been updated to
include Pixie devices, and the Visualizer will only support 50 pixels on a Unit ID until a future
update.

Hardware Support for New 4 port MP3 directors

Hardware Utility support for an upcoming 4 port MP3 Director has been added. This hardware has
not been released for sale yet.

Insert Pixie Device in the Sequence Editor

The Sequence Editor's Insert Device dialog can now insert Pixie devices with 2.4.8 or 16 ports.
New SD Card Wizard for writing MP3 Director SD cards in Hardware Utility

In support for the new 4 port MP3 director and other future improvements to SD card handling, the
way SD cards are written in the Hardware Utility has changed somewhat. The old Einal Options'
screen has been replaced with a wizard. There are no functionality changes.

Bug Fixes

¢ In many, but not all, cases when using the_Pixcon16 'simple' configuration if the RGB Triplet order
was changed it was not actually updated on the board.

e When updating the configuration of a PixCon16, an error 513 or 528 could appear if the wltage for
Bank 2 changed between the time the packet was written and the board was re-read.

¢ In some very rare cases, when writing a show to an SD card with the Hardware Utility, one or both
ports may not have been throttled.

e While running a show, if a sequence started playing that used video media, and the video mode
was set to Full Screen, the Show Player would not always put the video in full screen mode.

¢ In Superstar, if you clicked on an effect in the list box and the effect was in a group, the grouping
would be corrupted.
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¢ In Superstar, if you right clicked to bring up the color picker dialog while moving the mouse, the
dialog was not updated.

¢ In Superstar, on some computers, saving sequences to audio files to the desktop was not
working.

¢ In Superstar, spiral and fan effects that were part of a group would not stay as part of the group
when sawved.

¢ In Superstar, in some cases importing a matrix wizard with the origin set at the top were not
working.

¢ In Superstar, Star hotspots were being incorrectly drawn when in CCR and Floating window mode.
The hotspots are no longer drawn, matching the behavior when floating windows are turned off.

¢ In Superstar, changed an error message instead to a warning if an effect were added that
straddled a text action mask. The action is now allowed.

¢ In Superstar, saved state of the "Pixel Extender" if it was active, and warn the user that it is ON
the first time they try to run a sequence.

¢ In Superstar, when using the Pixel Extender, morph coordinates were being incorrectly clipped if
the Pixel Extender is shrinking effects.

¢ In Superstar, if you exceeded 64 columns by using force row/column in a prop and/or fixture, the
program would crash instead of producing an error.

¢ In Superstar, in some cases groups were not saved to clipboard files properly.

¢ In Superstar, while doing a copy/paste between two different instances of the program, the groups
were not pasted properly.

¢ In Superstar, the maximum number of image actions has increased from 5,000 to 10,000.

¢ In Superstar, the 'Scene Group Modify' wrap check box now supports 'no wrapping'.

¢ In Superstar, properly convert star scenes to RGB scenes when importing a visualization that has
a Superstar RGB star.

What's New in Version 4.3.14

¢ New Pixel Types supported on PixConl6

¢ New Test Mode available on PixCon16 configuration
e New PixConl6 Firmware

¢ New firmware for G3 MP3 directors
e Bug Fixes

New Pixel Types supported on PixConl6

The PixCon16 can now also run SK6812 (RGB only, not RGB+W), UCS1903 and P9813 pixels.
PixCon16 firmware of 1.4.11 or higher is required.

New Test Mode available on PixCon16 configuration

The PixConl6 can now be placed into hardware test mode using the Network Preferences
configuration program. PixConl6 firmware of 1.4.11 or higher is required.

New PixCon16 firmware

Firmware version 1.4.11 (filename PixCon16 Firmware Showtime (S4)-V1.4.11.nhx) has been
released and includes support for the new pixel types and test mode entry from abowve.

New Firmware for G3 MP3 directors
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Firmware version 5.36 has been released for the MP3q3 (filename: MP3g3-V5_36.Ihx), uMP3
(filename: uMP3g3-V5_36.lhx), and LOR1602g3MP3 (filename: MP3g3-V5_36.lhx) MP3 directors.
This firmware allows for faster show start-up when using DMX output exclusively.

Bug Fixes

¢ In some cases if a PixConl6 board were connected and searched for and the 'Minimum Required
Version' for the board was higher than the software could handle, it would not be shown at all
when it should have been shown in red.

e During an update of the PixCon16, the re-read of the board's configuration could time out. The
time out period was increased.

¢ In SuperStar, a bug was fixed that was limiting Visualizer locations to 50 in the y direction. This
has been increased to 360.

What's New in Version 4.3.12

e Altered SennoDog Utility parameter adjustment

e Select all effects in SuperStar

e Grouping effects in SuperStar

e Open each frame of an animated GIF in SuperStar

e Added info in SuperStar's Layout dialog for imported visualizations
e Bug fixes

Altered ServoDog Utility parameter adjustment

The ServoDog Utility now adjusts servo parameters relative to the channel's neutral trim and not with
absolute values.

Select all effects in arow in SuperStar
In SuperStar, you can now select all effects that are in a specified row in the the time layers.
Grouping effects in SuperStar

In SuperStar, you can now "group” effects in time layers. After making a group, you can "Expand"
and "Compress" the group. You can also "Ungroup" the effects.

Open each frame of an animated GIF in SuperStar
In SuperStar's "Import Image" feature, you can now open each frame of an animated GIF.
Added info in SuperStar's Layout dialog for imported visualizations

If you have imported a visualization in SuperStar, the Layout dialog box will now display the number
of channels in the visualization and the license level required to export the visualization.

Bug fixes
e SuperStar's mapping of visualization colors to the four basic colors has been improved. In

particular, 128,0,128 was being mapped to red, and now maps to purple.
¢ In the past, if you launched two instances of SuperStar and used a different audio file in each one,
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the first one launched would use the other one's audio file. This has been fixed.

What's New in Version 4.3.10

e New 'Round Robin' play for GAMP3 directors
¢ New Firmware for G3MP3 directors
e Bug fixes

New 'Round Robin' play for GAMP3 Directors

e G3MP3 directors, with a firmware upgrade, can now play sequences in a '‘Round Robin' when
using triggers.

New Firmware for G3MP3 Directors
e Firmware version 5.34 for both the G3-MP3 (filename: MP3g3-V5_34.Ihx) and the uMP3g3
(filename: uMP3g3-V5_34.1hx) director has been released to support Round Robin triggers.
e Firmware version 5.34 for the G3-MP3 (filename: MP3g3-V5_34.lhx) also fixes a problem where
DMX channels could be left in an inconsistent state when an SD card was inserted.

e Firmware version 5.34 for the uMP3g3 (filename: uMP3g3-V5_34.1hx) director now correctly turns
the status LED ON when a card is initially inserted.

Bug fixes

e When the Hardware Utility created a show for an MP3 Director with DMX channels, the DMX
channels would always be turned off at the end of the sequence regardless of what the value of the

"Keep lights ON at end if using DMX" option was.

What's New in Version 4.3.8

This version contains no functional changes, only some textual changes.

What's New in Version 4.3.6

e CF50D firmware

e Import Image in SuperStar
e Bug fixes

CF50D firmware
Version 1.05 of the firmware for the CF50D has been released (filename CF50D-V1_05.1hx). This
version fixes problems with delayed response when attached to an Enhanced LOR network. It is the
first version of firmware for the CF50D to be included with the LOR software suite installer.

Import Image in SuperStar

SuperStar now has an Import Image feature to import image files such as .jpg, .gif, .bmp, .png, and
.ico files.

Bug fixes
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e [f the first channel for SuperStar's star were set to anything but 1, export as intensity data to a
new file would fail because it did not create an empty channel for the container sequence.

e [f you did an "Export to Sequence Editor" in SuperStar when in CCR mode with DMX selected in
Configuration dialog box, then the first time you played to the screen, the effects would get shifted
and scrambled.

e |f you used an imported visualization in SuperStar, and the visualization contained a DMX Prop
name that contained an ampersand or quote character, then the Sequence Editor would fail to
open the exported file, displaying the error "Expected entity name for reference".

¢ |f a sequence has the white color in it, SuperStar now displays the white color even if the display
only has red, green, and blue in it. This is so that you can remowe the white color if you want.

¢ In SuperStar, white lights that were on a row that was below an RGB matrix could not be
sequenced. The effects could be added, but nothing would happen when you played it back.

¢ In SuperStar, if you created a Msualization with CCRs in it using "Create Quick Visualization", the
CCR rows would be disabled and could not be sequenced.

e Using Instant Sequence in SuperStar could have resulted in effects past the end of the song,
which would make the Sequence Editor unable to open the file.

¢ In very rare circumstances, the Visualizer could fail to start because of an issue with detecting the
Network Adapters available on the computer.

e |f a computer had more than 32 Network Adapters, or more than 32 IP addresses assigned to a
network adapter and the user selected 'Local' as the IP adapter to use, the Visualizer would
incorrectly report that the IP address could not be found, was blank, or was 0.0.0.0 when going
into simulation mode.

¢ In SuperStar, if a smooth effect with white in it painted to the first pixel of a CCR, then it would
write to the pixel resolution macro and cause the CCR to blink.

¢ In CCR mode with DMX selected and half ribbon selected, exporting as intensity data from
SuperStar would cause a crash.

¢ In CCR mode with half ribbon selected, the pixels were not exporting correctly from SuperStar (the
order of each half ribbon was not always correct).

e SuperStar's clipboard was fixed so that you can copy from one instance of SuperStar and paste
into another.

¢ The Sequence Editor's Insert Device dialog would add the universe number to a DMX universe's
name even if the "Include base unit ID in channel names" were disabled.

e When copying and then pasting a prop in the Visualizer, the additional Superstar Data was not
preserved.

e When exporting a prop from the Visualizer, Superstar data was not written to the file.

e A PixConl6 reboot is highly dependent on how fast a network DHCP sener responds to the IP
lease request. On certain networks with slow DHCP seners, an update of the configuration of a
PixCon16 with the Network Preferences program could sometimes throw an error. More time is
now given to the update process, and should that still not be enough an informational message is
generated rather than an error.

e When an update of a PixCon16's configuration failed, only a single error was used regardless of
the reason. Additional errors have been added to the update process as well as debug information
in some circumstances.

e On computers that are set up to use Japanese, and probably various other languages, the Comm
Listener would often put out strange error messages (ostensibly about having received
malformatted messages) and fail to work properly.

e SuperStar's "Wrapped Tree" feature was failing to create visualizations in some cases.

e When selecting or deselecting in SuperStar's sequencing grid when using a "Wrapped Tree"
Misualization, sometimes only some of the squares in a group were getting selected/deselected.

e SuperStar was not detecting the largest screen resolution, and was setting the wrong view size.

e The maximum number of RGB strings in SuperStar has been increased from 160 to 200.

e SuperStar's Positive Mask was always centering on the mask, and would not allow modification of

© 2017 Light-O-Rama, Inc.



24

Light-O-Rama v5.0.14

the coordinates.

SuperStar no longer saves the enable state of the pixel multiplier. Instead, it will always launch
with the pixel multiplier disabled. This is because if you were to launch with it enabled and start
sequencing, it would be very confusing because the playback of the sequence would be different
than expected, and it would look like things were broken if you didn't realize it was enabled.

If RGB dumbstrings in a Msualization are assigned the same DMX addressing, then when
imported into SuperStar, each RGB dumbstring was being assigned to its own square on the
sequencing grid. This has been fixed so that all RGB dumbstrings with the same DMX addressing
will be treated as if they are one fixture, and that one fixture will be assigned to only one square
on the sequencing grid.

What's New in Version 4.3.4

Improved "About" box in the Pixel Editor
Pixel Editor warnings for unsupported license level
Bug fixes

Improved "About" box in Pixel Editor

The Pixel Editor's "About" window now has a "Copy to clipboard" button to make it easy to paste
the displayed system information into forums and help tickets.

Pixel Editor warnings for unsupported license level

When Tools > Control Lights is selected in the Pixel Editor, the user is now warned if he or she
does not have a Pro license.

Also, the File > Sawe Intensity Data menu item is how enabled at all license lewels, but the user gets
an error message if they select it and do not have a Pro license.

Bug fixes

In SuperStar,stretching of DMX in CCR mode by specifying the pixel length of DMX pixels got
broken in version 4.2.10. It is now fixed.

In SuperStar, export of DMX in CCR mode in Half ribbon mode with controllers at the bottom would
get an error saying "Channel on wrong part of ribbon, export failed."”

SuperStar's "No Clip" rectangle has been fixed to be the entire matrix instead of being the first
matrix in the visualization.

The output of intensity data by SuperStar was dimmer than it should have been.

In some cases, the second time that a sequence was played during a run of a show, it would fail
with an error message saying "ERROR WITH SEQUENCE (Invalid play state (3) for
InitializeForPlay)", and the sequence would never successfully play again during that run of the
show. Now, if the Show Player notices a sequence in this invalid play state, instead of giving up
on trying to play the sequence, it will attempt to reset the sequence to clear out the problem so
that it can be played again.

In some cases, a seemingly random string of Chinese characters (seemingly not actual
meaningful Chinese text) would appear in LOR Control Panel's Status window. At least some
instances of this have been fixed.

If tooltips were disabled in the Sequence Editor, then the waveform cursor in the Pixel Editor did
not get displayed.

What's New in Version 4.3.2
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¢ Bug fixes
Bug fixes
e The Visualizer would claim that "Time is running backwards" and would not enter simulation

mode.
¢ In SuperStar's Instant Sequence, themes with scenes would not move in some cases.

What's New in Version 4.3.0

e CF50D in Insert Device

e Blanking out channel settings in Delete Controller

e Keys to view start or end of selection in the Sequence Editor
e Pixel Editor can now create New sequence files

e Pixel Editor playback window Always on Top

e SuperStar fonts maodified

e New Pixel Editor effects

e Creating sequences directly in the Pixel Editor

e Nested prop groups

e Tracking marker on Pixel Editor's timeline/waveform
e Channel conflict checks

e Repeat in picture and text effects

e Minimum number of props decreased
e Bulb size in effect thumbnails

e Better thumbnails for Curtain and Fireworks effects
e New way to access prop and group definitions

e Fffect Generator favorites improved

e Preview Design behavior changed

e Additional columns in Preview Info

e Default manual brightness in Effect Generator mixer
e Preview and Prop dropdowns wider

e Bug fixes

CF50D in Insert Device

The Sequence Editor's Insert Device dialog now can add CF50D devices to the sequence. Both
Cosmic Color Floods and UV Black Light Floods are supported.

Blanking out channel settings in Delete Controller

In the Channel Configuration screen of the Sequence Editor, the Delete Controller function used to
remove the channels of the selected controller from the track. You can now choose whether you
want that to happen or instead to leave the channels in place but blank out their settings (such as
unit ID and circuit).

Keys to view start or end of selection in the Sequence Editor

In the Sequence Editor, there are now keystrokes to move the display to ensure that the start or end
of the current selection is onscreen. Shift-Alt-Up and Shift-Alt-Down will display the first or last row
in the selection, respectively, and Shift-Alt-Left and Shift-Alt-Right will display the first or last column
in the selection, respectively.
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Pixel Editor can now create New sequence files

The Pixel Editor can now create a new sequence file rather than just work with existing Sequence
Editor files.

Pixel Editor playback window Always On Top

A new option has been added to the Pixel Editor to force the playback window on top of all other
windows.

SuperStar fonts modified
Three SuperStar font files have been modified: The characters i, j, u, v, and w have been modified in

10-12x12_Thin.custom.font and 10-12x12_Thin.system.font, and the characters u, v, and w hawe
been modified in 10-12x12_Thin_Vertical.system.font.

New Pixel Editor effects

Three new effects were added to the Pixel Editor: LinesVertical, LinesHorizontal, and Twinkle.
LinesVertical can be used to create marquee-style chase effects on rooflines, arches and frames.
You can use the Twinkle effect for a very slow twinkle, or a very fast strobe, and everything in
between.

Creating sequences directly in the Pixel Editor
You can now create new sequences directly in the Pixel Editor using the File > New menu item.
You no longer need to switch to the Sequence Editor to do this task. If your preview has props

where the Sequence Method=Sequence Editor, the channels for those items will automatically be
created in the LMS/LAS file and will be grouped by prop.

Nested prop groups
In the Pixel Editor, prop groups have a new arrangement option of "nested". In particular, this allows
nested stars to be grouped together and sequenced as a single item. Using this arrangement, the
Bar effect with direction=up mowves from the inside out. Bars left/right will move around all of the
nested props.

Tracking marker on Pixel Editor's timeline/waveform

As you mowve your cursor across the Pixel Editor's sequence grid, a marker is now displayed on the
timeline/waveform.

Channel conflict checks

In the Pixel Editor's Preview Info warnings box, all props are now checked for channel conflicts.
Previously only props with Sequence Method=Pixel Editor were checked.

Repeat in picture and text effects

For the Pixel Editor's picture and text effects, a repeat parameter was added. Default is "on" to
emulate previous functionality. Repeat=off causes just one scroll of the picture or text across the
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screen.
Minimum number of props decreased
Changed the minimum number of props in a group in the Pixel Editor from 2 to 1. This allows you to
create a preview group (a prop group where the arrangement setting=preview) for a single frame or
wreath, which can be useful for certain effects like fire.

Bulb size in effect thumbnails

When effect thumbnails are displayed in the Pixel Editor, bulb size is now taken into account. This
is especially helpful for RGB floods.

Better thumbnails for Curtain and Fireworks effects
Better thumbnails are now generated for Curtain and Fireworks effects in the Pixel Editor.

New way to access prop and group definitions
Prop and group definitions can now be viewed in the Pixel Editor by right-clicking on a prop hame in
the sequence grid and then selecting "View Prop Definition" from the pop-up menu. It is no longer
necessary to go into preview design just to check on the definition of a prop.

Effect Generator favorites improved
In the Pixel Editor, icons are now displayed in the Effect Generator's favorites tree so that folders
can be easily distinguished from effects. Also, organizing the favorites tree is now accomplished by
right-clicking on any item in the tree. New actions have been added that allow items to be moved up
or down, copied, exported to a file, or imported. There is also now a help icon in the favorites area -
clicking on it provides detailed instructions on how to use and manage effect favorites.

Preview Design behavior changed

In the Pixel Editor's Preview Design, the prop list no longer scrolls if you modify a prop (as long as
the prop name is unchanged).

Additional columns in Preview Info

Columns for Sequence Method and Dimming Curve have been added to the Pixel Editor's Preview
Info grid.

Default manual brightness in Effect Generator mixer
When switching to manual brightness for the first in time in the Pixel Editor's Effect Generator's
mixer, the default brightness value has been changed from 0% to 50%. Previously, when switching
to manual brightness, nothing was displayed in the middle window because the brightness value
was O.

Preview and Prop dropdowns wider

The Pixel Editor's Effect Generator's Preview and Prop selection drop-downs were made wider, so

© 2017 Light-O-Rama, Inc.



Light-O-Rama v5.0.14

that longer names are \isible.
Bug fixes

* In some rare cases, SuperStar was reporting duplicate channels when comparing an LOR channel
and a DMX channel.

e When the maximum number of sequencing rows has been exceeded, SuperStar will now display
an error message and suggest increasing the sequencing grid's "Max Length".

e Setting SuperStar's manual clip rectangle was only working correctly if you did the mouse drag
from upper left to lower right.

¢ |f you had DMX selected in SuperStar's Configuration dialog box, and had CCB selected in the
Layout dialog box, then "Export to Sequence Editor" was exporting invalid files.

¢ In SuperStar's Layout dialog box, some labels were changed: "CCR's" is how "CCR in Normal
Mode or CCB/CCP in Dual Normal Mode", and "CCB's" is now "CCB/CCP in Normal Mode".

e When creating an SD card for an MP3 Director in the Hardware Utility, sequences that only
contained lighting commands in Intensity Data could not be selected.

e Users who participated in the original S4 beta releases (4.0.0 - 4.0.38) and who had_Advanced
licenses were granted access as if they had purchased Pro. That access would have allowed the
user to set the 'Enhanced Network® for an LOR network ON. At the end of the Beta period, their
licenses reverted back to 'Advanced’, but the 'Enhanced Network' setting was still incorrectly set.

¢ |f you selected 1000K for the speed of an LOR network in Network Preferences, the "Enhanced"
checkbox would automatically become checked (as 1000K is currently only supported for
Enhanced networks). However, Enhanced networks are not supported if the license level is less
than Pro, and so the network would not work, but also you would have no way to turn off the
Enhanced setting.

¢ In SuperStar, if you had a scrunched visualization, and were doing instant sequence, there were
cases where it would only use red, green, and blue; if there were white strings they would never
get any effects.

e SuperStar's Pixel Extender was being used in CCR mode if it was enabled. This has been
changed so that the Pixel Extender only does something if in Visualization mode.

¢ |f a sequence’s filename, or the name of the directory path it was in, contained any of various
characters such as a parentheses, and the sequence were used in an interactive group in a show,
the sequence would not properly be loaded when the group's trigger was pressed.

e The Sequence Editor's New and Open dialog was displaying the Recent tab's right-click popup
menu as a main menu (on the dialog's menu bar).

e [f using a visualization of a mega-tree made with the S4 Visualizer Tree Wizard, the auto-clip
region for SuperStar images was only using 12 rows of the mega tree. This caused images to get
clipped to the first 12 rows.

e [f the audio path was not in the default path, SuperStar was not storing the path properly in the
sequence file exported to the Sequence Editor, and so the Sequence Editor would fail to find the
audio file.

¢ An error message is now displayed when SuperStar cannot find the visualization file.

e On some computers, the Pixel Editor's text effect would display text in the entry box but not in
the preview area. This has been fixed.

e [f errors occur in the Pixel Editor while calculating intensity data, a more detailed error message is
now displayed.

¢ For picture and text effects in the Pixel Editor, if movement is not "none", the initial positioning
has been fixed so that the text or picture starts off-screen and scrolls on-screen.

¢ For picture and text effects in the Pixel Editor, Peak-A-Boo movement now starts immediately.
Previously, the effect waited for a "peak-a-boo hold time" before the text or picture was first
displayed.

¢ When the selected prop is changed in the Pixel Editor's Effect Generator, the current effect now
restarts.
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e The mouse wheel and keyboard shortcuts now work while a tooltip is displayed on the sequence
grid in the Pixel Editor.

¢ A potential Pixel Editor crash after double-clicking on a blank cell in the sequence grid was fixed.

e A Pixel Editor crash when any arrow key is pressed and nothing is selected on the sequence grid
was fixed.

e Preview Info warnings in the Pixel Editor now show network name instead of network number (i.e.
Regular, Aux A, etc), and unit id's are now displayed in hexadecimal notation.

¢ A Pixel Editor crash in the Effect Generator when bulb size is invalid was fixed.

e The Pixel Editor's Visualizer import so that it no longer generates invalid bulb sizes was fixed.

¢ Fixed string assignments for the Fan shape clockwise layout (-CW) (previously the strings were
reversed) in the Pixel Editor.

e When double-clicking on an effect favorite in the Pixel Editor to recall it, if that effect had manual
brightness, the brightness value was not being restored.

What's New in Version 4.2.10

¢ |P Troubleshooter for PixConl6 devices

¢ Additional troubleshooting information in LOR Diagnostic
e Bug fixes

IP Troubleshooter for PixCon16 devices

If a PixCon16 is using Network Settings that are not compatible with the computer you are using,
you may not be able to configure it. The PixCon16 will appear in the_list of devices, however
selecting it will produce an error stating that the board cannot be configured. When this occurs, the
Network Preferences now offers to start an IP_troubleshooter which can try to fix the issue.

Additional troubleshooting information in LOR Diagnostic

LOR Diagnostic now collects additional information that may be useful for troubleshooting purposes,
via Windows Management Instrumentation (WMI). It collects some by default, and also now has an
"Advanced" screen that allows other WMI-based information to be collected.

Bug fixes

¢ The Pixel Editor's Fire, Fireworks and Meteor effects could have locked up (i.e. the effect freezes)
during the intensity calculation that occurs when a sequence is loaded. Once this happened,
those effects would be permanently frozen until the program was restarted.

e SuperStar's vertical matrix string pattern with the origin in the upper right or lower left was
importing backwards.

¢ The Pixel Editor could crash in rare instances while starting up.

What's New in Version 4.2.8

e Faworite names in Pixel Editor tooltips

e Changed display for shimmer and twinkle in the Pixel Editor
e New Pixel Editor option "Playback window is always on top"
e Bug fixes

Favorite names in Pixel Editor tooltips

If you hover over an effect on the Pixel Editor's grid, and that effect is a favorite, the favorite's name is
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now shown in the tooltip.

Changed display for shimmer and twinkle in the Pixel Editor

The Pixel Editor now displays a hash pattern on shimmer and twinkle effects on props where the
Sequence Method is "Sequence Editor".

New Pixel Editor option "Playback window is always on top"

The Pixel Editor has a new menu option: Tools > Preview Playback > Playback window is always on
top. If you are displaying the preview in a separate window and you press one of the play buttons,
when this option is enabled it will cause the playback window to immediately gain focus. Testing
has shown that this will help on some computers, but on others it will cause playback to be worse
(more jerky). Use with caution!

Bug fixes

The Light-O-Rama Control Panel can be set to automatically launch when Windows starts up. It
was not doing this in exactly the manner that it should have, and if some other program (unrelated
to Light-O-Rama) were doing it in the same incorrect way, that program and the Light-O-Rama
Control Panel would interfere with each other's automatic launching settings.

The first star channel in SuperStar's Configuration dialog box only allowed entries of 1-10 for the
channel's circuit ID. It has been changed to allow 1-11.

In Superstar, CCR mode half ribbons would not export in intensity data format correctly.

In SuperStar's Image mode, if you had manual clip set and did a left mouse click while holding the
Shift key to get the color of a pixel, it would also set the manual clip rectangle to that one pixel.
This was fixed so that you would now need to click and drag more than one pixel to do a manual
clip rectangle.

In SuperStar's Scene mode or Image mode, if you do a left or right mouse click while holding the
Ctrl key, it sets or clears all the pixels. A warning box was added to ask if you want that to
happen.

The Pixel Editor would hang while pasting when the number of rows in the clipboard was greater
than the number of writable grid rows.

Grid tooltips no longer display in the Pixel Editor when the Effect Generator is open.

Speed 0 has been removed from the Pixel Editor's Meteor effect, as it was not producing a useful
result.

The Pixel Editor's calculation of intensity data for groups of traditional strings has been fixed.
Playback in the Pixel Editor is how halted when switching tabs (i.e. when moving between
sequences).

What's New in Version 4.2.6

e CCB and Firefli options in SuperStar
e Faster E1.31 Universe Definitions in Network Configuration

e New system tray icons for LOR Control Panel
¢ Tooltips in the Pixel Editor's sequence grid

¢ Improved favorites display in the Pixel Editor
e Bug fix

CCB and Firefli options in SuperStar

The "CCB" and "Firefli" options are now back in SuperStar's Layout dialog box.
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Faster E1.31 Universe Definitions in Network Configuration

Now while editing a universe in the Advanced mode of the Network Configuration program, you can
specify a total number of universes that should have these identical settings.

New system tray icons for LOR Control Panel

The LOR Control Panel now uses new icons in the system tray, which are visually more in line with
the new program icons recently introduced in version 4.2.4:

aonn
Tooltips in the Pixel Editor's sequence grid

The Pixel Editor's sequence grid now displays tooltips similar to the way the Sequence Editor does.
In fact it uses the same set of tooltip display preferences. So if you want to change the way the
Pixel Editor is displaying tooltips on the grid, then you will need to open the Sequence Editor and
select Edit > Preferences > Display Preferences from the menu. Updated tooltip preferences will be
read by the Pixel Editor whenever you open a sequence.

Improved favorites Display in the Pixel Editor

If the Pixel Editor's current effect is stored as a favorite, the favorite's name is now displayed instead
of the technical description below the Effect Generator button.

Bug fix

¢ When displaying props whose seqguence method is "Sequence Editor" in the Pixel Editor's
sequence grid, in some cases the channel name would show "no matching channel” even though
the PE and SE physical channel information matched.

What's New in Version 4.2.4

e New PixConl16 Configuration field: Don't Create Universe Settings
e Pixel Extender can shrink as well as expand

e Decreased E1.31 comm usage

e CTB04 in Add Device

e New sample visualization files

e "Cool White" vs. "Warm White" in SuperStar

e New program icons

e Display order of props in the Pixel Editor

e Configurable filename suffixes in the Pixel Editor

e Bug Fixes
New PixConl6 Configuration field: Don't Create Universe Settings

When updating the configuration of a PixCon16 board, the Network Preferences program can
automatically create the E1.31 multi-cast settings necessary to run the universes defined. However
some users may have already created these settings and may not want them created again.
Setting this option will bypass that automatic creation.
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Pixel Extender can shrink as well as expand

The Pixel Extender feature in SuperStar can now shrink as well as expand. So now the "Number of
DMX Pixels" setting in the Configuration dialog box can be from 10 to 170 instead of from 50 to 170.

Decreased E1.31 Comm Usage

In some situations, when the lights for a DMX universe using E1.31 are all off, the Comm Listener
will now deliver fewer E1.31 packets than it had previously. This will result in less comm traffic on
the ethernet network, especially during long stretches of time when the lights are all off (for example,
idle time between shows).

CTB04 in Add Device

An option to add a four-channel LOR device (such as the CTB04) has been added to the Sequence
Editor's Add Device dialog.

New sample visualization files

Two new sample visualization files, 24x50Tree_8RowGlobe_BottomControllers.lee and
24x50Tree_8RowGlobe_DMX BottomControllers.lee, have been added.

"Cool White" vs. "Warm White" in SuperStar

"Cool White" and "Warm White" selections were added to the Configuration dialog box in SuperStar.
Some ribbons/strings are a cool white (they look bluish white when fully on) and some are a warm
white (they look yellowish white when fully on). Set this setting appropriately to best get your lights
to have colors that match the colors you saw on the computer screen when you made the

sequence.

New program icons
The various programs now have new main icons. It should now be easier to tell apart the various
programs in your task bar (and elsewhere). For example, here is an image of the taskbar with icons

for the Comm Listener, the Sequence Editor, the Hardware Utility, the Visualizer, and the Pixel
Editor:

B8N a

Display order of props in the Pixel Editor

In prior versions of the Pixel Editor, the order in which props were displayed in the sequence grid
was fixed. You still can't change the order of individual props, but now you can change the order by
type of prop. To do this, click on the "Props" button - located just to the left of the timeline, above
the sequence grid. In the "Select Props" window you can change the "Display Order" drop-down
selections to suit your needs. As an example, this feature can be used to mowve your beat track from
the bottom of the grid to the top.

Configurable file name suffixes in the Pixel Editor
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In prior versions of the Pixel Editor, when using File > Save As from the menu a suffix of "-Copy"
was added to the end of the original file name. This suffix is now configurable by going to Tools >
Preferences > Save As. One of the options is to add a suffix that contains the date and time, which
makes it very useful for creating backup copies of your sequence.

Bug fixes

¢ When updating the configuration of a PixCon16 board, the Network Preferences program may
occasionally throw an error 523 - Update Failed. If you subsequently check the configuration of
the board, you'll see that the configuration actually succeeded. This is due to an incorrect check
that was being performed.

¢ In SuperStar, visEffects would not work in floating windows after resizing the window.

e The number of matrix rows for a horizontal snake matrix in SuperStar was not correct. This made
it so the default clipping rectangle for the smooth effects was often too small.

¢ In SuperStar, a vertical snake matrix was not being imported correctly.

e The Pixel Editor no longer crashes if the "Arial" font is missing or corrupted, although you will be
unable to add or edit props until the Arial font is restored.

¢ The logic that refreshes the Pixel Editor's sequence grid during playback has been improved. As a
result, playback's "Force Refresh" option is no longer required and has been remowved.

What's New in Version 4.2.2

Change to starting the Control Panel while an instance is running
Page Left and Page Right in the Sequence Editor

Support for 340 pixels on a PixConl6 port

Simplified PixCon16 configuration

Faster response times when searching for and configuring PixConl16s
New DMX addressing options in SuperStar

Pixel Extender in SuperStar

Bug Fixes

Change to starting the Control Panel while an instance is running

There's nothing stopping a Windows user from trying to start a program any number of times, but
only one instance of the LOR Control Panel should be running at any given time. So, in previous
versions, if the Control Panel were started while another instance of it was already running, the
newly-started instance would simply stop, allowing the already-running instance to continue being
the sole running instance.

In some situations, this could be confusing, because it might seem to the user that they told the
Control Panel to start, and nothing happened. To address this issue, now, instead of just stopping,
the newly-started instance will first send a message to the already-running instance, causing the
already-running instance to display its status window, and also to refresh its icon in the computer's
system tray, in case it had disappeared for whatever reason.

Page Left and Page Right in the Sequence Editor

In the Sequence Editor, the Ctrl-Left and Ctrl-Right keys now operate as Page Left and Page Right.
Ctrl-Shift-Left and Ctrl-Shift-Right do the same but expand the selection instead of moving it. Also,
although Page Up and Page Down functionality was already cowvered by the Page Up and Page
Down keys, for the sake of consistency, Ctrl-Up and Ctrl-Down now operate as Page Up and Page
Down (similarly, Ctrl-Shift-Up and Ctrl-Shift-Down as Shift-Page Up and Shift-Page Down).
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Please note that unlike in the Page Up/Page Down case, there is not necessarily any relationship
between a "page" and the cells. That is, for Page Up/Page Down, one "page" consists of a certain
number of cell rows - i.e. a certain number of channels. But for Page Left/Page Right, one "page"
consists of a certain length of time, not a certain number of cell columns - i.e. a certain number of
timing marks. Timing marks can be anywhere, willy-nilly, or even nowhere, and do not necessarily
have any relation to the page. So, as compared to Page Up/Page Down, it may be more difficult to
predict exactly where your selection will move or expand to after a Page Left/Page Right.

Support for 340 Pixels on a PixCon16 port
The PixConl6 configuration now allows for a maximum of 340 pixels per port.
Simplified PixCon16 Configuration

Seweral changes have been made to the process and dialog boxes for PixCon16 configuration in an
effort to simplify them. Boards that were configured with earlier versions of Showtime will be
automatically converted to the new configuration. However there could be some incompatibility
between the old version and the new. You should carefully review your boards configuration the first
time it is edited in this new version.

To prevent future incompatibilities, once you have edited the configuration of a PixCon16 in the
Network Configuration, you should not use the PixCon16 assistant program in the future. If you do
use the PixConl6 Assistant program, be sure to double check your configuration to ensure that
settings were not changed.

Faster response times when searching for and configuring PixCon16s

The Network Configuration program used very conservative timing when searching for PixCon16
boards and during the load/save of the board's configuration. Those times have been shortened and
improve performance.

New DMX addressing options in SuperStar
Three new DMX addressing options were added to SuperStar's Configuration dialog:
e Tightly Packed: Uses all 170 channels available in each universe. Strings can hawe transitions
to the next universe in the middle of the string.
e Semi Packed: Puts as many full strings as will fit into each universe. Strings will not have a

transition to another universe in the middle of a string.
e Not Packed: Each string starts with a new universe.

Pixel Extender in SuperStar
The new Pixel Extender in SuperStar's configuration dialog box makes it so you can export 50 pixel
CCR sequences to DMX strings of any length from 50 to 170 pixels. This will make all the 50 pixel
CCR sequences that have been written transportable to displays that have DMX strings that have
more than 50 pixels.

Bug fixes

o After configuring a PixCon16 board, the user is asked if they would like to create the E1.31 entries
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in the Network Configuration for the DMX Universes in use on the board. Howewer in versions
previous to this, the 4 bridge port entries were not created even if they were in use.

e Using Instant Sequence rapid fire on 13 or more rows would cause a crash in SuperStar.

e |f a DMX fixture that was not part of a prop were used in SuperStar, it could cause an invalid name
to be put in for the fixture, leading to the Sequence Editor being unable to load the exported
sequence.

e |f SuperStar were unable to load the visualization at startup, it would cause a "failed to load
visualization" error every time it was launched. It will now instead change to use the default
visualization (which is "Sample.lee").

e |f you had entered an invalid number in the "Sensitivity" or "Length of Effects" fields in SuperStar's
Timing Map dialog box, the invalid value would get saved to a file, and every time you launched or
shut down SuperStar, you would get a warning message saying that the value needs to be in the
range 1-10.

e The Sequence Editor is supposed to remember the last used paste mode even between separate
runs of the program, but a bug was causing it to always start up as "Paste by Cell".

What's New in Version 4.2.0

e Warnings for incorrectly configured triggers

e New 1000K speed for LOR Networks

e New 1000K speed when creating SD cards for G3 MP3 directors
e Saving custom colors in SuperStar

e Flipping images in SuperStar

e Wait cursor during visualization loading

¢ New advanced option when creating SD cards for MP3 directors
e New 'comment' fields for Networks and Universes in Network Configuration
e PixConlé6 in Insert Device dialog

e PixConl6 Version V1.4.8 Firmware Support

¢ New pasting options in the Sequence Editor

e Merge Intensity Data Files in SuperStar

e Floating sequencing grid in SuperStar

e Memory usage improvements in the Pixel Editor

e File References in the Pixel Editor

e Windows Jump List compatibility for the Pixel Editor
e Maximum font size increase in Text effect

¢ New repeat mode option in Curtain effect

e Pixel Editor's Preview List window is resizable

e Prop Copy window remembers last position

e RGB channels for Insert Device's DMX Universe option

e Hardware Utility support for 50W Cosmic Color Floods

e Exporting and importing Pixel Editor props

e Importing Visualizer files to existing Pixel Editor previews
e Accumulation in Snowflake effect

e Allow for some PixCon16 configuration updates with older software
e Maximum images in SuperStar increased

e Bug fixes

Warnings for incorrectly configured triggers
If your trigger (no matter whether a show startup trigger or an interactive group trigger) is configured

to use a network that does not have a comm port set in Network Configuration, the Verifier will now
warn you with the new warning message number 53, "Trigger uses undefined network™".
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Also, since triggers are not supported on LOR Enhanced networks, the Verifier will now issue the
new warning message number 54, "Trigger uses LOR Enhanced network", if a trigger using such a
network is found.

Finally, despite the fact that triggers are not supported on LOR Enhanced networks, they can still be
tested on such networks by using the Hardware Utility. They will not, however, work during your
show. Therefore, if you have any LOR Enhanced networks designed, the Hardware Utility's input
testing screen will warn you about this fact.

New 1000K speed for LOR networks

A new speed of 1000K has been added for LOR Networks in the Network Configuration. Currently
only the PixCon16 board running on an Enhanced LOR Network can run at this speed.

New 1000K speed when creating SD cards for G3 MP3 directors

A new speed of 1000K has been added to the Hardware Utility when creating SD cards for G3 MP3
directors. To use the new speed, you must have a G3 MP3 director with updated firmware. The
only device that can currently run at 1000K is the PixCon16 in Enhanced LOR mode.

Saving custom colors in SuperStar

In SuperStar's Color Picker dialog box, you can now save custom colors.
Flipping images in SuperStar

You can now "Flip Left-Right" and "Flip Up-Down" for images in SuperStar.
Wait cursor during visualization loading

When loading a visualization in SuperStar, a wait cursor now appears.
New Advanced Option when creating SD cards for MP3 director

A new option has been added to the Advanced Options of the SD Card creator in the Hardware
Utility. The new option lets you optionally set the throughput efficiency of the MP3 director.

New 'Comment’ fields for Networks and Universes in Network Configuration

A new comment field has been added for each Network or Universe that can be configured in the
Network Configuration program.

PixConl6 in Insert Device dialog

The Sequence Editor's Insert Device dialog now has a PixCon16 option, which can be used to insert
PixConl6 devices.

PixConl16 Version 1.4.8 Firmware Support

The software now supports version 1.4.8 firmware of the PixConl6. This is a minor firmware revision
that only changes how the status and power lights work, and includes no other new functionality.
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New pasting options in the Sequence Editor

In previous versions of the Sequence Editor, there was a "Paste from Foreground” option. If it were
turned on, then when you pasted, only the copied effects that were not completely off would be
pasted. This sort of control has now been expanded into the "Paste From/To" options: In addition to
Paste from Foreground, you can now also Paste from Background (i.e. pasting only the copied
effects that are completely off), and also Paste to Foreground (paste only onto effects that are not
completely off) and Paste to Background (paste only onto effects that are completely off). You can
even combine the "from" and "to"; for example, paste from foreground to foreground.

Merge Intensity Data Files in SuperStar
SuperStar now has support for merging intensity data files.

Floating sequencing grid in SuperStar
In SuperStar, you can now put the sequencing grid and the visualization each in their own floating
window. Before, there were cases where the visualization would be very small. This gives control
over the size of the region used for the sequencing grid, and the size of the region for the
visualization. Also, if you have two monitors you can mowve the sequencing grid to one monitor and

the visualization to the other monitor.

To activate the feature, click on the "View" menu and select "Floating Windows".

Memory usage improvements in the Pixel Editor

Memory used by the Pixel Editor has been dramatically reduced. This should allow you to easily
open longer sequences with more pixels and more prop groups. Memory used is now proportional to
the total length of the effects populated in the sequence.

File References in the Pixel Editor

There is a new menu option in the Pixel Editor: Sequence > File References. This will open a
window that lists all files referenced by Movie and Picture effects. It also has an option to specify a
new location for those files - which can be useful if you move your sequence directory.

Windows Jump List compatibility for the Pixel Editor
The Pixel Editor is now compatible with Windows' "Jump List" feature. If you pin the Pixel Editor to

the task bar and right-click on it, you will see a list of recently opened LMS/LAS files from which you
can select.

Maximum font size increase in Text effect

In the Pixel Editor's Text effect, the maximum font size has been increased. This allows for larger
and more readable text, especially for matrices with less than 10 rows.

New repeat mode option in Curtain effect

The Pixel Editor's Curtain effect has a new repeat mode option: repeat_at_speed_rotate_colors. This
causes the curtain to display with a different color in your palette every time it opens.
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Pixel Editor's Preview List window is resizable
The Pixel Editor's Preview List window is now resizable.
Prop Copy window remembers last position

When you open the Pixel Editor's "Prop Copy" window, it opens at the size and position that you
last had it open.

RGB Channels for Insert Device's DMX Universe option

When adding a DMX universe through the Sequence Editor's Insert Device dialog, you can now
optionally add RGB channels instead of regular channels.

Hardware Utility support for 50W Cosmic Color Floods
The Hardware Utility now is able to correctly identify 50W Cosmic Color Flood controllers.
Exporting and importing Pixel Editor props

The Pixel Editor now can import and export preview props. This allows you to export props from one
preview and import them into a different one. It also allows you to share your props with others.

Importing Visualizer files to existing Pixel Editor previews

The Pixel Editor has had the ability to import a Visualizer (.LEE) file into a new preview. Now you
can also import into an existing preview.

Accumulation in Snowflake effect

The Pixel Editor's "snowflake" effect has an additional parameter to control snow accumulation.
Please note that in order to accommodate this change, the meaning of the first and second palette
colors in the snowflake effect have changed. Now, the first color is always the main color and the
second color is the highlight color. In versions 4.1.2 and prior, the first color was the highlight color
the second color was main color for flake types larger than single-pixel flakes.

Allow for some PixCon16 configuration updates with older software
When needing to update the configuration of a PixCon16, the Network Configuration program would
look at the Firmware Revision of the board to decide if it could be used to update that board or not.
Howe\er, in the future there could be_firmware updates that do not require changes to the Network
Configuration program. This would force a user to update LOR Showtime for no other reason than to
use a hew PixConl6 firmware.

Now if the board revision is found to be greater than 1.4.6, additional checks are performed to see if
an older version of software can successfully update the board.

Maximum images in SuperStar increased

The maximum number of images in SuperStar has been increased from 1000 to 1500.
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Bug fixes

e After version 3.12.2, the_Advanced Settings' button was inadvertently remowved from the final
options of writing an SD card in the Hardware Utility. The button has been returned.

¢ If the SuperStar configuration file SSEdit.cfg did not exist when SuperStar was launched, the
program would crash. This could happen on a fresh install to a computer that has never had the
Light-O-Rama Software Suite installed on it.

¢ If a sequence having a Windows shell command were changed to no longer use any such
command, the command would be eliminated from LOR's internal list of known commands. This
would have the intended effect that the sequence would no longer cause the command to run, but
it would also have an unintended side effect: If you were to restore a backup of your sequence
sawe file, which still was supposed to use the command, that restored old version would also not
run the command. Moreower, if any other sequences had been using the same command (which
would have required manual modification of the sawve files), they also would no longer run it. Now,
instead of eliminating the command from LOR's list of known commands, the command is merely
eliminated from the sequence itself.

¢ In the Sequence Editor, if you tried to copy, cut, or paste in a loop level, a bizarre and minimally
comprehensible error message would appear. It now more clearly states that you cannot copy,
cut, or paste loop lewvels.

¢ If the user attempted to edit a Network or Universe that was using advanced parameters while in
Simple mode, the Network Configuration program could leak resources and/or refuse to end

properly.
e The Comm Listener port could not be changed in the Network Configuration program while in
Simple mode.

e The Comm Listener port, as well as the 'Send To' Port on a DMX Universe when using E131 was
not validated and could be set to nonsensical values. The value is now checked to ensure it is
numeric and between 0-65535.

¢ In very limited circumstances after an upgrade from a beta version, the Network Configuration
program would refuse to start and give a cryptic 'Runtime Error 380" and/or 'Invalid Property' error.
This error has been resolved.

e Depending on the source sequence, an SD card written by the Hardware Utility could have been
incorrectly throttled leading to out of sync sequences when run on a MP3 director. SD cards
created by earlier versions of S4 should be re-created with this version.

¢ In the Insert Device dialog of the Sequence Editor, the DMX Universe option would not pay
attention to the "Name" field. It would instead always name the channels as if you had selected a
name of "DMX".

¢ When using the Advanced Rendering Engine, the Visualizer was ignoring the Max Opacity setting
of RGB Flood Light fixtures. A bug fix in Version 4.1.2 for the same root cause failed to fix the
problem for RGB floods.

¢ Importing a visualization into SuperStar would sometimes report nonexistent errors.

¢ In SuperStar's Configuration dialog box, the unit ID and start channel of the star were reverting to
original numbers if you clicked on the "LOR" or "DMX' radio buttons.

¢ In SuperStar, the "matrixlength" keyword was not working if the prop used row/column
coordinates.

¢ In SuperStar, group modify for scenes used in the star were not being modified.

¢ \When exporting the SuperStar display as intensity files, all the channels in the 16 channel
controller that controls the star were being exported. Now, only the six channels used to control
the star are exported. This is important because if the other channels in the controller for the star
are used to control other lights, then the blank intensity data for those channels would make them
shimmer and blink.

¢ \When exporting the SuperStar display in Legacy format, made it so that only the channels defined
in the visualization file are in the export.

¢ In SuperStar, when using morphs with a visualization, only the 1a and 1b morph anchor labels
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were being displayed in the visualization. This has been fixed so that the 1a, 1b, 2a, and 2b labels
are drawn. In addition, lines are drawn between the labels in the same manner as they are drawn
in the sequencing grid. If using a matrix or tree made of RGB lights this can make it easier to
specify morphs by clicking on the \isualization instead of the sequencing grid.

e Bugs in the Pixel Editor's drawing of the red playback marker have been fixed. Users have a new
menu option: Tools > Playback Options > Fast Playback Marker. Normally, this option should be
enabled/checked, as it uses the least system resources. Howeer, if you are using a tool such as
Screencast-O-Matic, the red playback marker may still display incorrectly. In this case, turn the
"Fast Playback Marker" option off (uncheck), and the grid and playback marker will display
normally - even during screencast recording.

e [f you built the sequence that is part of the Pixel Editor Introduction (video or PDF presentation), in
the final version with the cross-fades the effects reset at the end of the ramp up and at the start of
the ramp down. This is especially noticeable in the Countdown effect. This has been fixed - so the
ramp-up, full intensity, and ramp-down are considered one continuous effect.

e Improvements to the Pixel Editor's Spiral effect: no more gaps on 100% thickness, fully consistent
as rotation is changed, Show 3D can now trail either left or right, and spirals are spaced more
evenly.

e Animation sequences (LAS files) with large numbers of pixels did not always play back in the
Pixel Editor at the correct rate. This has been fixed.

e A Pixel Editor crash could occur while audio was being loaded if the audio contained a sample
with the absolute minimum value. This has been fixed. It was noted in the "Open Beta Bug
Reports" forum as bug SC08.

¢ Fixed a few remaining Pixel Editor screen layout issues on high resolution displays - any time
Windows' "Text Resolution" setting is greater than 100%.

e The firmware for PixCon16s was using the LHX extension, howewer these firmware files can not be
loaded by the Hardware Utility, they must be loaded by the Network Configuration program. The
extension was changed to NHX to prevent confusion.

What's New in Version 4.1.2

e Automatically switch to new timing grid

¢ New Candy-Cane shapes in Pixel Editor

* Consolidated list of props in Pixel Editor's Preview Info
e Bug Fixes

Automatically switch to new timing grid

When creating a new timing grid in the Sequence Editor, you can now optionally have the active
track automatically switch to using the newly created timing grid.

New Candy-Cane shapes in Pixel Editor

The_Pixel Editor's Prop Definition window now has selections for candy-canes, both left and right
facing.

Consolidated list of props in Pixel Editor's Preview Info

A consolidated list of all props with their associated channel information has been added to the Pixel
Editor's Preview Info window (accessed from the Tools > Manage Previews menu). There is a Copy
button that will put all of the channel information on the clipboard so it can be pasted into Excel, or a
similar spreadsheet program.
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Bug fixes

¢ When using the Advanced Rendering Engine, the Visualizer was ignoring the Max Opacity setting
of Flood Light fixtures.

¢ In the_Pixel Editor, if the user attempted to save a color palette with a name that already existed
the program could crash.

e An error was introduced in 4.1.0 in the Pixel Editor when importing a Visualizer .LEE file with
duplicate prop names.

¢ In the Pixel Editor, if the user changed the string type from Traditional' to 'RGB' in the prop
definition window, the Pixel Editor could crash.

What's New in Version 4.1.0

Pixel Editor documentation

The Saved Palettes option of the Pixel Editor has moved
Additional clip rectangle group modify support in SuperStar
Enhanced naming in SuperStar

Enhanced sparkle in Effect Generator

Centering for bar effect

Clarified Instant Sequence defaults

Bug fixes

Pixel Editor documentation

Documentation for the Pixel Editor, which was previously distributed as a standalone file, is now
integrated in this help file.

The Saved Palettes option of the Pixel Editor has moved
Previously, there was a separate option the Tools menu where you could delete/copy/rename your
Saved Palettes in the Pixel Editor. This function has been mowed to inside the Effect Generator's
‘Star' menu and called ‘Manage Palettes’.

Additional clip rectangle group modify support in SuperStar

Support of clip rectangle group modify was added for shockwave, spiral, and fan smooth effects in
SuperStar.

Enhanced naming in SuperStar

The naming of the wrapped tree visualization file and the wrapped guide text file in SuperStar have
been enhanced so that all parameters of the wrapped tree are encoded in the nhame.

Enhanced sparkle in Effect Generator

The slider for the sparkle setting in the Pixel Editor's Effect Generator has been changed so that the
value can change over the course of the effect.

Centering for bar effect

A "Center" parameter has been added to the Pixel Editor's bar effect. Now the center point can be
adjusted for expand and compress variations of the effect.

© 2017 Light-O-Rama, Inc.



42

Light-O-Rama v5.0.14

Clarified Instant Sequence defaults

In SuperStar's Instant Sequence dialog, the buttons "Set TCM Defaults 1" and "Set TCM Defaults 2"
have been replaced by "Set Normal Defaults"and "Set Rapid Fire Defaults".

Bug fixes

¢ |In some situations, for sequences that have animations, deleting a controller or channels in the
Sequence Editor would lead to various errors, for example a "subscript out of range" error. Such
errors would not necessarily occur only in the Animator; the fact that the sequence had an
animation would cause the problem elsewhere as well.

e The Pixel Editor's startup check for the correct version of OpenGL has been fixed. The user can
no longer open sequences if the version of OpenGL is less than 1.5.

¢ The Pixel Editor would not correctly handle when a pixel string had more channels than the "max
channels” setting.

e After a Visualizer import, a bug in Prop Definition could cause the Pixel Editor to crash.

¢ The Pixel Editor was assigning the wrong unit ID on CCRs during Visualizer import.

¢ The Pixel Editor was not correctly handling Visualizer import when one or more channels had a
device type of "none".

¢ When loading a sequence file, the Pixel Editor would only read the first track.

e The "More Info" button in the Pixel Editor's Sequence Editor migration tool now displays
messages in a scrollable window. Previously, if there were a lot of messages, the window size
could exceed the screen size.

¢ Display of the starting channel number in the Pixel Editor's Prop Definition is suppressed if the
corresponding string number is skipped in the custom prop grid.

What's New in Version 4.0.38

Undo and redo in the Pixel Editor preview design
Pixel Editor prop definition window resizable
Pixel Editor documentation

Bug fixes

Undo and redo in the Pixel Editor preview design

The Pixel Editor's preview design now has undo and redo capability. This applies to prop movement,
but not to adding or deleting props.

Pixel Editor prop definition window resizable
The Pixel Editor's prop definition window is now resizable.
Pixel Editor documentation

Documentation for the Pixel Editor is now available. It has not yet been worked into this help file
document, but can be found on the web at:

http://www.lightorama.com/help/L ORPixelEditorHelp. pdf

A copy of the document is also distributed by the installer. It can be found in the Light-O-Rama
program files directory, which is typically, but not always, either C:\Program Files\Light-O-Rama or
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C:\Program Files (x86)\Light-O-Rama.
Bug fixes

e The Pixel Editor was unable to load some large sequences when attempting to migrate channels.

¢ Drawing of timing marks in the Pixel Editor was not working correctly on high DPI displays.

e The Pixel Editor would crash when the device type was set to Unconnected/None in the prop
definition.

e Some bugs in the movement options of SuperStar's Instant Sequence dialog box were fixed.

What's New in Version 4.0.36

¢ Relaxed requirements for Cosmic Color Devices in Visualizer

e Better 'Force to Front' handling in the Visualizer

e Control Sequence Editor Play/Stop during Visualizer simulation
e Sequence Editor performance improvements

e Clip Rectangle in SuperStar

¢ Rotate Selected Image in SuperStar

e Prop rotation handle in the Pixel Editor

e Adjustable Pixel Editor background image brightness

e Zooming in the Pixel Editor

e Bug fixes

Relaxed requirements for Cosmic Color Devices in Visualizer
In previous versions, when simulating Cosmic Color Devices, the Visualizer required that the fixture

when assembled had exactly 50 pixels with no gaps. CCDs now instead follow the relaxed rules
that DMX Pixel Universe fixtures follow. That is, you can skip pixels and/or use less than 50 pixels.

Better 'Force to Front' handling in the Visualizer

When using the Visualizer's 'Force to Front' option along with channels that required the use of the
Listener, the Visualizer could not be set back into the background. This was because of periodic
data messages the Listener is required to send, even if no data is changing. These periodic updates
would force the Visualizer back to the top even if no sequence was currently running. Instead now
the Sequence Editor sends a separate message to the Visualizer to tell it that you are starting play
of a sequence. This will only happen once when you start the sequence, allowing the Visualizer to
be pushed back into the window stack afterward.

Control Sequence Editor play/stop during Visualizer Simulation

When the Visualizer is placed in Simulation mode, two new buttons have been added that allow you
to start and stop playing the active sequence in the Sequence Editor. To start the active sequence
press the 'Play SE' button. This performs the same action as if you went to the Sequence Editor's
'Play’' menu and then selected 'Start This Sequence'. To stop the play of a sequence, press the
‘Stop SE' button.

Sequence Editor performance improvements

Version 4.0.34 introduced changes that decreased the loading times of sequences (for example, in
the Sequence Editor). Unfortunately, these changes also increased the length of time that various
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other things took, including, notably, saving, exporting, importing, and opening the right-click popup
menu on a channel group button. These things have been sped up again, including some that are
now even significantly faster than they had been before version 4.0.34 slowed them down. For
example, on a certain huge sequence on a certain machine, saving took about 16 seconds before
4.0.34, but 142 seconds in 4.0.34, and is now back down to about 16 seconds again; importing a
certain huge configuration file took about 518 seconds before 4.0.34, 663 seconds in 4.0.34, and
now takes about 85 seconds; opening the right-click popup menu took about seven seconds before
4.0.34, and about 39 seconds in 4.0.34, and is now basically instant.

Clip Rectangle in SuperStar
"Clip Rectangle" has been added to SuperStar's Image Group Modify dialog box.
Rotate Selected Image in SuperStar
"Rotate Selected Image" has been added to SuperStar's Image setup dialog box.
Prop rotation handle in the Pixel Editor
In the Pixel Editor's preview design, props are now displayed with a rotation handle to the right of the
selected prop (similar to the Visualizer). Just grab the handle and drag it with your cursor to rotate
the prop. Note that only one prop can be selected for the rotation handle to be displayed.
Adjustable Pixel Editor background image brightness
The brightness of the Pixel Editor's preview's background image can now be adjusted from the main
window. With a sequence open, click on the small down arrow next to the preview name. Select
"Background Image" from the dropdown menu, then select the desired brightness (10% - 100%).

Note that this setting only affects image brightness during preview playback; image brightness
during preview design is a separate setting.

Zooming in the Pixel Editor

Zoom in and zoom out buttons have been added to the Pixel Editor's sequence toolbar (the same
buttons that are in the Sequence Editor). You can still zoom in and out using the previous methods
- dragging over the waveform to zoom in, and right-clicking on the waveform to zoom out - but there
are now two ways to zoom.

Bug Fixes

¢ In the Sequence Editor, in some situations, certain actions such as grouping channels would
cause the track to stop being displayed.

¢ In some situations, inserting channels in the Sequence Editor would not work.

e Some movement patterns in SuperStar's Instant Sequence were not behaving properly.

What's New in Version 4.0.34

Channel-related performance improvements
Cosmetic changes for Network Configuration program

Change Intensities
New CB100D Firmware

New CMB16D Firmware
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e Verifier checks for recommended Show Player options
e Slider in Pixel Editor Effect Generator upgraded
e Bug fixes

Channel-related performance improvements

Changes have been made to improve performance related to channels, RGB channels, and other
channel groups. For example, a certain enormous seguence which previously took 143 seconds to
load on a certain machine now takes 81 seconds on the same machine. The vast majority of the
remaining time is taken by loading effect events within channels, as opposed to loading the
channels themselves, and the Smooth to Fades tool can be put to good use on the effect events of
this particular sequence: The same sequence, but modified via the Smooth to Fades tool, used to
take 82 seconds to load before this performance improvement (as opposed to 143 without Smooth to
Fades), and now takes 19 (as opposed to 81 without Smooth to Fades).

Cosmetic changes for Network Configuration program

Various small changes have been made to the Network Configuration program to simplify its use.
For example, the X10/Dasher and Options tabs have been combined into a single new tab called
‘Misc'. These changes are cosmetic only and do not change any functionality.

Change Intensities

The Sequence Editor now has a Change Intensities command, which can be used to change the
intensities in the selected area in a wide variety of ways. For example, you can add to or subtract
from intensities, impose caps or floors, and scale them (for example, double them or halve them).
The tool can be set up to apply to all channels or only to certain types of channels (for example, to
RGB channels' red channels).

You can access the Change Intensities tool via the Change Intensities submenu of the right-click
context menu.

New CB100D Firmware

Version 1.21 of the Cosmic Color Bulb/Cosmic Color Pixel firmware has been released. This version
fixes a problem with LOR Enhanced mode and the last channel (310) of the unit not working when
in Extended ID Mode.

New CMB16D Firmware

Version 1.34 of the CMB16D 16 Channel DC controller firmware has been released. This new
firmware will continuously read the status of the address switches so the Hardware Utility can no
longer be used to update the Unit's ID. This change also allows for the CMB16D to now have a
speed setting while in stand-alone mode. Setting an address that starts with F (FO-FF) will actually
make the unit's ID 01, and the second digit (0-F) will control the speed of the stand-alone program
running from 0:Slow to F:Fast.

Verifier checks for recommended Show Player options

The Show Player options Use Compressed Sequences and Show Player Memory Restarts (both
accessible via the LOR Control Panel's right-click popup menu) both, when enabled, give possible
benefits while causing no drawbacks. They are thus both recommended to always be enabled. The
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only reason the option to disable them is given is as a sort of "safety" in the case of some
hypothetical, unforeseen bug, so that if you have some very specific reason to believe that one of
them is causing a problem, you can turn it off. The Verifier now checks to see whether or not they
are enabled, and if not, issues warning messages saying so (messages number 51 and 52,
respectively).

Slider in Pixel Editor Effect Generator upgraded

In the Pixel Editor's Effect Generator, many effects use a slider to control effect behavior. In this
release, the slider has been upgraded to allow the setting of a start value (effective when the effect
begins) and an end value (effective when the effect completes). This allows you to do such things as
having a spiral slow down or speed up during the course of the effect.

The top of the slider (green) represents the start value. The bottom of the slider (red) represents the
end value. By default, the start and end values are locked together. To specify different start and
end values, the slider must be unlocked. This is done by double-clicking anywhere along the slider.
When unlocked, the top and bottom pointers can be moved independently. To relock, just double-
click the slider again.

Bug fixes

¢ In SuperStar, strings of lights that are not CCDevices or DMX pixels were always being given the
incandescent dimming curve. Now the strings use the LED dimming cune if they are RGB dumb
strings or if they are specified as LED in the channel dialog box of the Visualizer.

e The LOR Control Panel's status window would not show log messages that occurred while the
status window was itself not displayed.

¢ In rare circumstances, the Pixel Console of the Hardware Utility could refuse to control pixels on a
DMX Universe, if an unrelated LOR Network adapter had a problem.

e When using the Pixel Console on an LOR unit in Enhanced LOR Mode, the last pixel (#100) could
not be fully controlled.

e The Pixel Editor requires video drivers supporting OpenGL wersion 1.5 or later. If a PC did not
support this, the Pixel Editor would crash when opening a sequence. Now, the Pixel Editor
instead detects this situation, gives the user an informative message when the Pixel Editor starts,
and disables the opening of sequences.

¢ A bug in the movement of scenes when using the Rapid Fire trigger in SuperStar's Instant
Sequence was fixed. If it was more than one pixel, the scenes could get messed up when
traversing over an unused area.

What's New in Version 4.0.32

Change Effect Type

Test Tracks' Physical Lights

Background image can be displayed during main window playback
Bug fixes

Change Effect Type

The Sequence Editor's right-click context menu now has a "Change Effect Type" submenu that can
be used to change the effect types of all the events in the selected area of the sequence, while

keeping their intensities the same. For example, a fade up from 0% to 37% followed by an intensity
of 37% can be changed to a twinkling fade up from 0% to 37% followed by a twinkle of 37%.
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Test Track's Physical Lights

The Sequence Editor's right-click context menu on a track grid now has a new submenu "Test
Track's Physical Lights". Using the various items in this submenu, you can make the physical
lights for all of the channels in the track turn on, off, shimmer, or twinkle, or else do whatever the
seguence says they are supposed to do at the time that you clicked in the track grid.

Background image can be displayed during main window playback

In the Pixel Editor, the background image for the preview can now be displayed during main window
playback. This feature is controlled via a new menu option: Tools > Preview Playback > Show
background image.

Bug fixes

¢ |f the Sequence Editor's "Test Physical Channels" command were used on a Cosmic Color
Device, commands would be sent not only to its pixels, but also to its macro channels, potentially
leading to strange results. The commands are now only sent to pixels, skipping the macro
channels. Howewer, note that it is possible to control an actual physical Cosmic Color Device
from the Sequence Editor without the Sequence Editor knowing that it is a Cosmic Color Device;
the macro channels will only be skipped if the Sequence Editor knows that the channel group
represents a Cosmic Color Device (for example, if it had been added to the sequence as a CCD
via Insert Device).

e [f the Sequence Editor's "Test Physical Channels" command were used on a channel group or
RGB channel (as opposed to on a single channel), it would be needlessly inefficient with the
commands it sent to the lights over the comm line. This wouldn't have a noticeable effect in most
cases, but it could possibly cause lagginess if a very large number of channels were in the
channel group.

¢ In the Pixel Editor's Visualizer import, LOR unit IDs greater than 09 were not imported correctly.

¢ In the Pixel Editor's Visualizer import, channel settings for bundles/superstrings were not used
during playback, even though they were displayed properly in the prop setup window.

¢ In the Pixel Editor's prop setup window, the maximum allowed segments per line has been
increased.

¢ During the Pixel Editor's sequence playback, pixels were often not square when playing back on
the main window. Now, pixel dimensions are even recalculated if the playback window is resized
during playback.

What's New in Version 4.0.30

e "Test Physical Channel" can be used on RGB channels and channel groups
e Smooth to Fades
e Bug fixes

"Test Physical Channel" can be used on RGB channels and channel groups

The "Test Physical Channel" commands in the Sequence Editor's right-click popup menu on
channel buttons used to apply only to actual channels, as opposed (for example) for RGB channels.

You could use them on the individual channels comprising an RGB channel, but not on the RGB
channel as a whole. You can now use these commands on RGB channels and other channel
groups, turning on or off all channels in the group in one fell swoop.

Smooth to Fades
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Sometimes, sequences (especially those created with the help of various automatic tools) will have
sections wherein a channel will have many very rapid consecutive effect events. For example, "From
time 0.00 to time 0.05, 10%; from time 0.05 to time 0.10, 30%; from time 0.10 to time 0.15, 40%,;
from time 0.15 to time 0.20, 70%". If done on many channels, this sort of thing can lead to laggy or
bursty behavior. Moreower, it's often more or less indistinguishable (to the human eye) from the
simpler "From time 0.00 to time 0.20, fade up from 10% to 70%", which is significantly more
efficient. The Sequence Editor now has a "Smooth to Fades" tool which will attempt to
automatically smooth out effects in this way, which can improve the performance of the sequence
(reducing lagginess) and also decrease loading and saving time. You can get to the Smooth to
Fades tool via the track grid's right-click context menu.

Bug fixes

e The Hardware Utility would crash without warning when using the Pixel Console if the Comm
Listener was not active and the REGular port was not defined as 'Enhanced'.

e Consecutive picture effects in the Pixel Editor would not display the correct images.

¢ When creating a new prop in the Pixel Editor, an error would occur if the user selected the string
type as "strobe string 1 ch" or "multicolor string 1 ch" before selecting a color.

What's New in Version 4.0.28

The Pixel Consale in the Hardware Utility can now test PixConl16 and other devices running in
ELOR mode

e Visualizer props imported into the Pixel Editor

e Sequence method defaults for importing Visualizer fixtures into the Pixel Editor

Pixel Editor prop groups can contain any prop

'More Info" buttons on Sequence Editor-to-Pixel Editor migration tool
e Bug fixes

Pixel Console in the Hardware Utility can now test PixCon16 and other devices
running in ELOR mode.

The Pixel Console in the Hardware Utility could previously only test PixConl6 devices when running
in E1.31 (DMX ower Ethernet). It can now also test PixConl6 boards, or any other LOR controller

that are connected to the REGular LOR Enhanced network running at 500K.

Visualizer props imported into the Pixel Editor

In the Pixel Editor's Visualizer import function, Visualizer props now get imported as Pixel Editor
prop groups.

Sequence method defaults for importing Visualizer fixtures into the Pixel Editor

In the Pixel Editor's Visualizer import function, string, single bulb, and flood fixtures now default the
Sequence Method to Sequence Editor. CCR and DMX fixtures default the Sequence Method to
Pixel Editor.

Pixel Editor Prop Groups can contain any prop

Pixel Editor prop groups can now contain any prop, not just those with a Sequence Method of Pixel
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Editor.

"More Info" buttons on the Sequence Editor-to-Pixel Editor migration tool

"More Info" buttons were added on the Sequence Editor-to-Pixel Editor migration tool, to show exact
channel mismatches.

Bug fixes

¢ In SuperStar's Smooth Effects dialog box, if the Enter key were pressed while the tab pane had
the focus, the pane would go blank. It now does not go blank, and sets the current values to the
screen.

¢ In SuperStar's Smooth Effects dialog box, if the Esc key were pressed while the tab pane had the
focus, the pane would go blank. It now instead closes the dialog box.

¢ In SuperStar's Smooth Effects dialog box, if the Esc key were pressed while the tab pane did not
have the focus, the dialog box would close, but the tab pane would remain. Now both go away.

¢ When importing or exporting a network configuration in the Network Preferences program, if the
filename contained a special character (such as a space), the import or export could fail silently or
the file could be saved with an incorrect filename.

e When changing the Unit ID or Universe ID in the Pixel Console, the pixels displayed should have
reset to show the first pixel. However this was not happening.

¢ When changing a DMX universe to use E1.31 in the Advanced Network Configuration, if there were
no previous settings the IP is set to Multicast with the correct address rather than Specify with an
IP of 0.0.0.0.

e |f the user previously configured a DMX Universe in the Advanced Network Configuration, those

values are used as the defaults for the next DMX Universe edited if that universe has no previous

settings.

The Pixel Editor would crash when opening some sequences.

The Pixel Editor would sometimes have incorrect channel assignments on custom props.

The Pixel Editor's preview playback would not update when in a separate window.

The Pixel Editor's Effect Generator was not detecting the "none" effect correctly.

What's New in Version 4.0.26

Physical channels can now be tested in the Sequence Editor
Importing Visualizer files into the Pixel Editor

Pixel Editor playback performance improved

Bug fix

Physical Channels can now be tested in the Sequence Editor

If you right click on a physical channel in the Sequence Editor, you can now send an ON command
directly to that channel. This will allow you to test if you have properly configured and connected

your equipment, and that you have correctly set the channel's parameters. The channel will remain
ON until you select to turn the channel OFF, or you play a sequence.

Importing Visualizer files into the Pixel Editor

You can now import Visualizer files (*.lee) into the Pixel Editor. In the Pixel Editor, select Tools >
Manage Previews from the menu, then click on the "Import Visualizer" button. This functionality is
preliminary - only fixtures get imported at this time. It is intended that in a future release, Visualizer
props will also get imported as Pixel Editor prop groups.
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Pixel Editor playback performance improved

The performance of sequence playback has been improved in the Pixel Editor.
Bug fix

¢ In the Pixel Editor, the timing mark display no longer bleed through if the user switches to another
window/application during playback.

What's New in Version 4.0.24

e Hardware Utility can take control of ports from the Comm Listener
e PixConl6 can now be automatically configured as 1 UID/Universe per port
e Bug Fixes

Hardware Utility can take control of ports from the Comm Listener

Only one program can have a comm port open at any given time. For ports associated with LOR
Enhanced networks and DMX networks, typically the Comm Listener will have the port open. In
previous versions, this meant that if you wanted to use the Hardware Utility on such a port, you
would have to ensure that the Comm Listener was not running, which is typically done via "Unload
Light-O-Rama" in the LOR Control Panel's right-click popup menu. Now, instead, when the
Hardware Utility cannot open a port and it suspects that the reason might be that the Comm
Listener has that port open, it now offers you the choice of whether or not it should ask the Comm
Listener to temporarily give up control of the port. Thus, you can use the Hardware Utility on such
ports without completely unloading the LOR Control Panel.

Two things should be noted: First, if you ask the Comm Listener to give up control of the port, then
no program other than the Hardware Utility will be able to control lights on that port (until the Comm
Listener retakes control of it). Notably, this means that if a show is running, any lighting commands
from the show for the lights on that port will not take effect. Similarly with lighting commands from
the Sequence Editor or Pixel Editor.

Second, the Hardware Utility does not really know that the Comm Listener is the culprit that is
preventing it from opening the port; it just has a good guess that this might be the case. The culprit
might instead be some other program entirely; for example the Sequence Editor might have the port
open, or even some program completely unrelated to Light-O-Rama. So, if the Hardware Utility asks
you if you want it to ask the Comm Listener to give up control of the port, and you say yes, this
might not cause the Hardware Utility to be able to take control of the port. In some cases, you
might still have to (for example) close the Sequence Editor.

PixCon16 can now be automatically configured as 1 UID/Universe per port

When configuring the PixCon16, the only way to automatically have the board assign ascending
Universe or LOR Unit IDs previously was to use the ‘Advanced' configuration and manually create the
parameters for each port. The PixConl16 configuration can now perform this task automatically in
simple or advanced mode. In simple mode, select the 'One UID/Universe per port' radio button. In
Advanced configuration use one of the 2 buttons which automatically update all lower ports with
ascending unit IDs.

Bug fixes
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e When automatically creating Network Configuration while configuring a PixCon16, not all DMX
Universes in use were being created.

¢ In the Hardware Utility the 'Lights Off button on the bottom right of the main screen was not
turning all lights off on Cosmic Color devices

What's New in Version 4.0.22

e Prop creation is now optional when using the DMX Pixel Draw or CCR Pixel Draw Wizards
e PixConl6 can now be configured to run in LOR mode
e PixConl6 configuration can now optionally create DMX Network Configuration on save

e More robust PixConl16 communications for loading board configuration and updating firmware
e Bug Fix

Prop creation is now optional when using the DMX Pixel Draw or CCR Pixel
Draw Wizards

Previously, when finished drawing a_DMX Pixel Universe or a CCR String, it was always required to
create a new prop. However many times these wizards are used to continue adding pixels to
existing fixtures. These wizards now ask if you want to create a new prop or not.

PixConl1l6 can now be configured to run in LOR mode

The PixConl6 has 2 operation modes: It can be used as an E1.31 controller on an Ethernet
network, or it can be used as an LOR controller on an LOR RS485 network. Now the user can
specify which mode to use the board in, and will change its operation accordingly (Unit IDs instead
of Universes, Circuit IDs rather than Channels, etc.)

PixCon16 configuration can now optionally create DMX Network Configuration
on save

When the PixCon16 is in E1.31 (DMX) mode, saving the configuration will bring up an option to
automatically create the necessary DMX Network configuration changes. If the user selects yes, for
each DMX universe in use on the board the system will create Multicast entries in the network
configuration.

More robust PixCon16 communications for loading board configuration and
updating firmware

Previous versions took a very consenvative approach when reading or writing to the board, including

during firmware updates. Now the read/update process will retry more often and at a faster rate in
an effort to reduce the number of errors the user has to deal with.

Bug fix
e When creating DMX Pixel Universes using a Wizard, the Visualizer would not correctly display

fixtures with available pixels. Instead the wizard would crash and leave the Visualizer in an
inconsistent state.

What's New in Version 4.0.20
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¢ Bug Fix
Bug fix

e The Hardware Utility main window was improperly sized allowing for controls that should have
been hidden to be visible.

What's New in Version 4.0.18

Sequence Editor's comm status more informative and more accurate
Hardware Utility can now more easily test Cosmic Color Ribbons and Bulbs/Pixels
Separate tab for traditional strings in prop definition window

Custom bulb colors for traditional strings in the Pixel Editor

Bulb shape and transparency in the Pixel Editor

New Pixel Editor prop shape, "Bulbs"

Increased maximum bulb size in the Pixel Editor

Overriding default channel settings in the Pixel Editor

Props comment field

Renamed Pixel Editor sequence method

Color selection palette hidden for effects that do not use it

Movie effect support for uncompressed AVI files

New default for Pixel Editor migration tool

Custom Pixel Editor dimming curves

Wait dialog while saving intensity files

Bug fixes

Sequence Editor's comm status more informative and more accurate

There is a small colored square in the bottom right corner of the Sequence Editor which indicates
the status of various networks: Blue means ewverything's OK, red means some sort of problem

exists, and orange means other (for example, if Control Lights is off). This has been improved in
several ways in this version of the Sequence Editor:

¢ In S3, it would only indicate the status of LOR networks. In earlier beta releases of S4, it
would actually indicate less than that: It would only indicate the status of non-enhanced LOR
networks. It now also indicates the status of non-enhanced LOR networks and of DMX
networks (although see below for a caveat).

e Previously, if an error existed on some network, its tooltip would simply say that there is an
error. It now indicates which network or networks have errors.

e Previously, starting play would in some cases make the panel turn from red to blue even if
some network still had an error.

¢ |t now updates in close to real time when some sort of status change happens.

Two things should be noted: First, for LOR enhanced networks and for DMX networks, the status
describes whether or not the Sequence Editor is successfully communicating with the Comm
Listener; it does not necessarily indicate that the Comm Listener is successfully communicating
with the network. Check the Comm Listener itself for that information. Second, only the statuses of
LOR and DMX networks are taken into account at this time; the statuses of Dasher, X10, Digital 10
and BSOFT Digital IO networks are not reflected.
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Hardware Utility can now more easily test Cosmic Color Ribbons and Bulbs/
Pixels

Previously, the Hardware Utility Test screen could only_test up to 32 circuits on a device. Cosmic
Color devices howewer can have 150 or more circuits, which could lead to user confusion. Now when
a Cosmic Color device, like the Cosmic Color Ribbon or Cosmic Color Bulb, is selected the test
screen changes to testing the entire device with a particular color rather than circuit by circuit.

Separate tab for traditional strings in prop definition window

On the Pixel Editor's prop definition window, the details of setting up a traditional string have been
mowved to a separate tab from RGB strings.

Custom bulb colors for traditional strings in the Pixel Editor

In the Pixel Editor, traditional strings can now have a custom bulb color (defined with the rest of the
string colors). Press the "Custom" button to set the color.

Bulb shape and transparency in the Pixel Editor

Bulb shape and bulb transparency were added to the Pixel Editor's props. These can be set in the
preview design window after one or more props have been selected.

New Pixel Editor prop shape, "Bulbs"

The Pixel Editor has a new prop shape of "Bulbs". Each bulb in the prop can be individually
positioned.

Increased maximum bulb size in the Pixel Editor

The maximum possible bulb size in the Pixel Editor has been increased so as to better
accommodate flood lights.

Overriding default channel settings in the Pixel Editor

It is now possible to owerride the default channel settings for every channel in a prop with traditional
strings in the Pixel Editor. For example, a traditional megatree with red and green strings can now
have a channel configuration of RRRR...GGGG.... Previously, it had to he RGRGRGRG....

Props comment field

The Pixel Editor has a new comment field for props, which you can use to enter your own notes
about the prop.

Renamed Pixel Editor sequence method
The Pixel Editor's "Traditional" sequence method has been renamed to "Sequence Editor".
Color selection palette hidden for effects that do not use it

The color selection palette on the Pixel Editor's Effect Generator window is now hidden for effects
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that don't use the palette (e.g. Picture and Movie effects).
Movie effect support for uncompressed AVI files

The Pixel Editor's Movie effect can now read uncompressed AVI files produced by the fimpeg
program.

New default for Pixel Editor migration tool

The Pixel Editor's "Remove prop channel data from Sequence Editor" migration tool defaults to
checked if the Pixel Editor and Sequence Editor channel counts match and the Has SE Events
columnis Yes.

Custom Pixel Editor dimming curves

You can now create your own dimming curves for the Pixel Editor, placing them in the "Pixel Editor
\Curves" directory within your LOR data directory.

Wait dialog while saving intensity files
The Pixel Editor now shows a wait dialog while saving intensity files.

Bug fixes

The Pixel Editor would hang after pressing play when the audio file was missing.

The Pixel Editor would crash if a sequence was opened, closed, re-opened, and then the preview
was changed. A memory leak related to this was also fixed.

A bug in the Pixel Editor's onscreen playback of strobes was fixed.

A Pixel Editor bug dealing with custom RGB props with multiple strings has been fixed.

After a "Save As" was done in the Pixel Editor, the Pixel Editor file (LPE) had a timestamp that
was current, but the new LMS/LAS file's timestamp was the same as the original file. Now both
files will have a timestamp that is current.

What's New in Version 4.0.16

e Pixel Console in the Hardware Utility can now test DMX pixels
e Sequence Editor no longer turns off Control Lights when a port cannot be opened
e Bug fixes

Pixel Console in the Hardware Utility can now test DMX Pixels

The Pixel test Console in the Hardware Utility has been improved to now be able to test DMX pixels.
DMX Pixels can only be tested when the Comm Listener is running and if your software is

registered at the Advanced level or higher.

Sequence Editor no longer turns off Control Lights when a port cannot be
opened

In previous ersions of the Sequence Editor, if any particular comm port for an LOR network could
not be opened, the Sequence Editor would automatically turn off Control Lights and therefore not
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attempt to control lights on any network. The reason for this was that it would be very resource-
intensive to keep trying to open a comm port that just could not be opened, to a degree that would
noticeably affect play. Now, instead, the Sequence Editor will leave Control Lights on, but not
attempt to control the specific problematic network (or networks). If you find yourself in this
situation, and you fix the problem with the comm port, you can get the Sequence Editor to attempt
to open the port again by manually turning Control Lights off and then on.

Bug fixes

e For some DMX visualizations, SuperStar would not export all of the pixels.

¢ In certain situations, the Visualizer when in normal rendering mode would not display all fixtures
properly.

¢ \When entering Simulation Mode in the Visualizer, DMX Pixel Universe fixtures were not being
properly flagged as an error if they contained duplicate pixels.

What's New in Version 4.0.14

¢ Network Preferences Program can export/import network configurations
e Right click copy in the Pixel Editor

e Dragging effects in the Pixel Editor

e Owerlapping channel warnings in the Pixel Editor

¢ New Pixel Editor prop types

e Control over beat interval range in SuperStar

e Bug Fixes

Network Preferences program can Export/Import network configurations
There are two new buttons on the Network Preferences Advanced configuration that allow for the

export and import of user network configurations. These functions can be used to keep multiple
configurations on the same computer, or to move configurations between computers.

Right-click copy in the Pixel Editor

In the Pixel Editor, you can right-click on an effect thumbnail and select "Copy" from the popup
menu. This puts the effect on the clipboard, from where it can be pasted anywhere on the grid.

Dragging effects in the Pixel Editor

In the Pixel Editor, you can drag an effect thumbnail onto a grid cell, and that cell will then be
populated with that effect.

Overlapping channel warnings in the Pixel Editor

In the Pixel Editor's Preview Management window, clicking the "Info" button now lists warnings
where channel assignments overlap (in addition to listing basic statistics about the preview). This is
a great way to check whether you have any errors in creating your preview.

New Pixel Editor prop types

The Pixel Editor's prop types "Line-Horizontal" and "Line-Vertical" have been replaced with "Lines-
Closed Shape", "Lines-Connected", and "Lines-Unconnected”, which can be used to create a much
larger variety of shapes. Any Line-Horizontal props in your preview will be automatically converted to
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a Matrix-Horizontal that is one string high. Line-Vertical props will be automatically converted to a
Matrix-Vertical that is one string wide.

Control over beat interval range in SuperStar

When doing a "Create Timings" in SuperStar, a dialog box now appears, giving control over the
range that the beat interval can be. The default range is what it used to be a year ago so that Carol
of the Bells is given a short beat interval that matches what is in the first SuperStar tutorial.

Bug fixes

¢ In some very limited cases, the_Network Preferences program would produce an error stating that
a COM port and a DMX adapter were in conflict but were not. This same bug could also manifest
itself as an 'Error 9 - Subscript out of Range' error and crash when starting the Network
Preferences program.

e [f the user pressed ESC while in simulation mode using the Advanced Rendering Engine,
Visualizer would completely exit rather than return to Edit Mode.

¢ The position of the Visualizer Advanced Rendering Engine window would not be remembered
between executions.

What's New in Version 4.0.12

e Checkmark for currently selected waveform size
e Bug fixes

Checkmark for currently selected waveform size

The Pixel Editor now shows a checkmark in the menu next to the currently selected waveform size.
Bug fixes

¢ In some situations, the Light-O-Rama Control Panel would issue an error message saying "Error
in Form_Unload: (91) Object variable or With block variable not set".

e Lighting commands for DMX universes would not be sent to the Visualizer unless "Control Lights"
was enabled, even if "Control Visualizer" was enabled.

e Lighting commands for LOR Enhanced networks would be sent to the physical controllers if
"Control Visualizer" was enabled, even if "Control Lights" was not enabled.

e The way that SuperStar's configuration is saved has been changed for better backward
compatibility.

e On some computers, if the Pixel Editor's preview playback window lost the focus, the playback
would be blank.

e The Pixel Editor would only allow one universe for custom props.

¢ Media files longer than twenty minutes were not loading in the Pixel Editor.

What's New in Version 4.0.10

e MP3 directors running DMX universes can now optionally leave lights on at the end of a sequence.
e Commands menu in LOR Control Panel

e Comm Listener starts even if no networks are configured to use it

e Pixel Editor migration tool to remove channel data from sequence
e Pixel Editor preview data now stored in LOR data path
e Pixel Editor Design & Playback window split into two windows
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Pixel Editor toolbar changes

Pixel Editor preview playback changes

Windows Media Player used for all Pixel Editor playback
Bug fixes

MP3 Directors running DMX Universes can now optionally leave lights on at the
end of a sequence.

A new option has been added to Hardware Utility when creating SD cards for MP3 directors to either
leave channels on DMX Universes at their current intensities or else turn them off when a sequence
ends.

Commands menu in LOR Control Panel

The Light-O-Rama Control Panel's right-click popup menu is now also accessible from its Status
window, as the "Commands" menu. Generally speaking, this may (or may not) be more convenient
in some situations, but it could be very useful in certain situations where Windows repeatedly keeps
closing the popup menu automatically before you get a chance to select the menu item that you
want to use from it.

Comm Listener starts even if no networks are configured to use it

In previous \ersions, the Light-O-Rama Control Panel would not start up the Comm Listener unless
at least one network was configured in Network Preferences to use the Comm Listener. It now no
longer requires any such networks to be configured. This allows commands to go through the
Comm Listener to the Visualizer even if no networks at all are configured to use the Comm Listener.

Pixel Editor migration tool to remove channel data from sequence file

The Pixel Editor migration tool to remove channel data associated with Pixel Editor props from the
sequence file (LMS or LAS file) is now operational. This tool should be used only after you hawe first
imported your sequence using the Sequence Editor import and/or the xLights import. The benefit of
this tool is that it eliminates any owverlapping channels between the sequence file and the intensity
file, which is necessary for proper playback outside of the Pixel Editor. It can also greatly reduce
the size of your sequence file.

Pixel Editor preview data now stored in the standard LOR data path

The Pixel Editor previously stored the preview data file under the hidden AppData directory. It now
stores it in the standard LOR data path, and no longer stores any data under AppData.

Pixel Editor Design & Playback window split into two windows

The Pixel Editor's Design & Playback window has been split into two separate windows, one for
design and the other for playback. This was a prerequisite for solving other playback issues.

Pixel Editor toolbar changes

The Pixel Editor's toolbar above the sequence grid has been revamped to look more uniform. Also,
playback buttons were added, as were some options that were previously in the Sequence menu.

Pixel Editor preview playback changes
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The Pixel Editor's preview playback can now be hidden, shown on the main window, or shown on a
separate window. Even when on a separate window, the grid remains interactive. The choice of
which mode to use is under the new Tools > Preview Playback menu, and applies to all sequences.

Windows Media Player used for all Pixel Editor playback

Windows Media Player is now used for all media playback in the Pixel Editor. Previously, the
displayed audio waveform (compressed audio) was used for playback on the main window, but this
had low sound quality.

Bug fixes

¢ In SuperStar, regular light string effects would not work in certain visualizations.

e The SuperStar star was not getting marked properly if it also had row/column coordinates.

e The Comm Listener would ignore lighting effects for DMX universes that were not set up in
Network Preferences. As a result, the effects would not be displayed in the Visualizer.

e SuperStar has improved error reporting when importing visualizations with DMX pixels.

¢ In the Pixel Editor's Preview Design window for "Dumb RGB" and traditional strings, moving an
end point on such a string would cause the drawn string to collapse to a single point.

e The Pixel Editor's media file search was not locating files in subdirectories under the default LOR
media directory.

What's New in Version 4.0.8

e New CMB16D firmware

e Dumb RGB elements in groups
¢ Clockwise and counterclockwise pixel orders in Window Frame props

¢ Prop creation dialog change
e Bug fixes

New CMB16D firmware
Version 1.33 of the firmware for the CMB16D has been released (filename CMB16-1-33.l1hx). This

new version has no effect on functionality; it is being released because the recently released
previous version 1.32 would incorrectly be displayed in the Hardware Utility as being version 1.31.

Dumb RGB elements in groups

In the Pixel Editor, dumb RGB elements can now be members of a group.

Clockwise and counterclockwise pixel orders in Window Frame props

In the Pixel Editor, the user can now specify Window Frame props to use clockwise (CW) or
counterclockwise (CCW) pixel order. Users who have created Window Frame props with previous
beta versions will need to go back into those prop definitions and update the Start Location value to
match their prop.

Prop creation dialog change

In the Pixel Editor's prop creation dialog, the number box next to the DMX radio button (max
channel/circuit number) now applies to both DMX and LOR networks. In particular, this resolves an
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issue when defining props based on the CMB24DC card.
Bug fixes

e The Comm Listener is designed to shut down when the LOR Control Panel shuts down. In
previous versions, this behavior relied upon the LOR Control Panel periodically sending "keep
alive" messages to the Comm Listener; if the Comm Listener didn't receive such a message within
a reasonable amount of time, it would shut itself down. This worked fine most of the time, but in
some situations (typically involving very large shows), the LOR Control Panel would sometimes
not get a chance to send such a message to the Comm Listener for a while, leading to the Comm
Listener shutting itself down prematurely. Now, instead of relying on these messages, the Comm
Listener periodically directly checks whether or not the LOR Control Panel is running.

e SuperStar's progress dialog box works smoother.

¢ In SuperStar, play of a song sometimes wouldn't stop until the end of the song was reached.

e The Verifier is supposed to check for the existence and correct version numbers of various
program files (in Verifer message number 7 and number 16 respectively), but it was not doing so
for several relatively new files.

e The Network Preferences program could incorrectly identify two or more networks as being in
conflict when they were actually not.

e The Pixel Editor now displays unit IDs in hex on the prop layout window.

e The Pixel Editor's "Control Lights" command was always using the default port to attempt to
connect to the Comm Listener, even if the Comm Listener were configured to listen on a different
port.

e The Pixel Editor could crash during migration of custom props.

¢ The preview calculation for LOR channels in the Pixel Editor was producing a range of 0-100
instead of 0-255, which made them appear dim (both as part of the preview and as part of the
Sequence Editor migration). Users should rerun any Sequence Editor migrations they performed
using version 4.0.6.

What's New in Version 4.0.6

e Highlighted thumbnail in Pixel Editor effects
e Comm Listener no longer requires FTDI drivers
e New firmware for CMB16D card

e New Pixel Editor Sequence Editor migration tool
e New Pixel Editor effect: Movie

e Performance improvements in the Pixel Editor

e Bug fixes

Highlighted thumbnail in Pixel Editor effects

In the Pixel Editor's table of effect thumbnails, the current thumbnail is now highlighted, making it
easy to distinguish which thumbnail is playing in the right-hand window.

Comm Listener no longer requires FTDI drivers

Previous versions of the Comm Listener required FTDI drivers to be installed on the computer, even if
the Comm Listener weren't supposed to drive any lights that use FTDI-based adapters. It now no
longer requires these drivers. If they are not installed, then the Comm Listener will not be able to
control any lights on FTDI-based networks (such as LOR Enhanced networks and most types of
DMX networks), but it will be able to control the Visualizer, and also control lights on E1.31
networks.
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New firmware for CMB16D card

Version 1.32 of the firmware for the CMB16D card has been released (filename CMB16-1-32.Ihx). It
now supports 500K comm speed and LOR Enhanced protocal.

New Pixel Editor Sequence Editor migration tool

The Pixel Editor has a new Sequence Editor migration tool. From the menu: Sequence > Migration
Tools > Import from Sequence Editor. It will allow sequences for RGB props to be copied into the
Pixel Editor. The result will be an exact pixel for pixel copy displayed as a single effect that spans
the length of the sequence (one effect per imported prop). Portions of that single effect can then be
removed and replaced with Pixel Editor effects as desired.

New Pixel Editor effect: Movie

The Pixel Editor has a new effect: Movie. This effect will play AVI movie files on your props (files
with an "av" extension). This effect is a bit limited in that the AVI movie files must be
"uncompressed”. Various third-party programs (such as VirtualDub) can be used to produce such
uncompressed AVI files.

Performance improvements in the Pixel Editor

The Pixel Editor has received some performance improvements: There has been some modest
improvement in the preview calculation speed, and a large speed improvement to the Pinwheel effect
(meaning it now takes far fewer CPU cycles to calculate).

Bug fixes

¢ In SuperStar, if you attempted to export an intensity file to a directory other than the sequences
folder, the empty *.Ims file got placed in the correct folder, but the associated intensity file always
got placed in the sequences folder.

e When a visualization file would get a "ran out of sequencing rows" error, SuperStar would
sometimes freeze.

¢ Preview of text on SuperStar's sequencing grid was being clipped to only the matrix in a
visualization that contained a matrix and other lights. It will now display the preview of the text to
the entire sequencing grid.

¢ If the Comm Listener were configured to use some particular adapter, but it could not open that
adapter, lighting commands sent to the Comm Listener for that adapter's network would build up
without being processed until the adapter was successfully opened. This would result in the
Visualizer unnecessarily not receiving the lighting commands either, and also potentially lead to
an out-of-memory condition eventually.

e Ramp up effects on the left side of the Pixel Editor's grid were displayed incorrectly.

¢ In some cases, Sequence Editor channels were not being displayed in the Pixel Editor's grid even
though they were selected after clicking the "Props" button.

e The Pixel Editor's xLights 3 import tool is now located under the Sequence > Migration Tools

menu.
e SuperStar now remembers the clip rectangle state for Smooth Effects mode, Image mode, and
Text mode.

What's New in Version 4.0.4
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e New CMB24D firmware
e Bug fixes

New CMB24D firmware

Version 1.05 of the firmware for the CMB24D card has been released (filename CMB24D-V1_05.1hx).
It has support for the Enhanced LOR Protocol.

Bug fixes

e [f you did not have an LOR USB dongle attached to the computer and attempted to start the Pixel
Console, it would crash the Hardware Utility with no error message.

¢ In the Visualizer if in one session you ran a simulation with the Advanced Rendering Engine and
then switched options to the Regular engine, the simulation would not run.

¢ The Visualizer was not correctly reporting issues with simulations that used pixel universes. This
could lead towards the Visualizer deleting fixtures coming out of simulation.

¢ One of the things that the Light-O-Rama Post Install utility does is to give you a chance to choose
the directory that Light-O-Rama will (by default) use to store your data files (such as your
sequences and visualizations). If you previously had chosen a data directory, then ran Post Install
again and told it to use a different directory, it would copy your data from the old directory to the
new. Howewer, it would not copy all such data; in particular, data files that you had stored in
subdirectories would not typically be copied over to your new data directory.

What's New in Version 4.0.2

'Spokes” prop shape in Pixel Editor

Pixel Editor pinwheel effect improvements

Visualizer will back up S3 and earlier Editor Files before converting to S4
Comm Listener identifies clients by name in log messages

New Pixel Test Console for the Hardware Utility

Tracks and props now remember whether or not they are hidden

New sample visualization file

Bug fixes

"Spokes" prop shape in Pixel Editor

The Pixel Editor has a new predefined prop shape called "Spokes", for props that have spokes that
radiate from a central hub.

Pixel Editor pinwheel effect improvements

The Pixel Editor's pinwheel effect has new controls: Two sliders to control the center of rotation, and
one to control the length of the arms.

Visualizer will back up S3 and earlier Editor Files before converting to S4
The file format of Visualizer files has changed. When saving an S3 file in S4, the Visualizer will first

back up the editor file. Should you choose not to mowve to S4, you can use this backup file to
restore to an S3 format.

Comm Listener identifies clients by name in log messages
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When issuing a log message about one of its clients (such as the Sequence Editor or Show Player),
the Comm Listener would refer to the client via the IP socket that the client used to connect to the
Comm Listener. For example, it might refer to a certain client as "Socket 127.0.0.1:57223". This is
enough to uniquely refer to the client (at least until it disconnects and later reconnects), but it's not

terribly informative for troubleshooting purposes. Now it additionally refers to the client by name
(such as "Sequence Editor"), if the client has identified itself to the Comm Listener in that way.
Please note that not all clients will necessarily identify themselves to the Comm Listener in all
situations, so in some cases the Comm Listener will still only log the IP socket information.

New Pixel Test Console in the Hardware Utility

A new testing console that can more easily be used with Light-O-Rama RGB devices has been
added to the Hardware Utility.

Tracks and props now remember whether they are hidden

In the Sequence Editor, when you opened a sequence, all tracks and the props section would be
unhidden, even if you had previously hid some of them while that sequence was open earlier. The
sequence now remembers whether or not they should be hidden even after it is closed and
reopened.

New sample visualization file

A new sample visualization file, 24x25Tree_8RowGlobe_dmxPixelTool.lee, has been added.

Bug fixes

When the Pixel Editor was displayed on a secondary monitor, the timing marks would display
incorrectly during prop playback.

In the Pixel Editor, when creating custom props that skipped node numbers, the program would
crash.

In the Pixel Editor, when creating custom props that used the same node number more than
once, the prop would display some nodes in the wrong locations.

When loading certain sequences into the Pixel Editor, the program would crash. This would
happen with sequences that had more than one channel assigned to the same physical circuit. It
would also happen with sequences that used the same channel name more than once.

The version number displayed in the Pixel Editor's "About" box did not match the rest of the Light-
O-Rama programs (it had an extra ".0" in it).

The caption on the Pixel Editor's main window was missing some of the information displayed in
the captions of other Light-O-Rama programs.

In certain cases after unexpectedly disconnecting from and successfully reconnecting to the
Comm Listener, a client may not have correctly told the Comm Listener whether or not lights
should be turned off the next time that it disconnects.

In the Visualizer when using the Arch Wizard to create a pixel based fan, the fan was not properly
created.

When the Pixel Editor displayed effect thumbnails in the left window, thumbnails for Firestick
props were bunched too close together. A similar problem could occur for horizontal lines.

When a log message is added to the LOR Control Panel's status window and it is beyond the end
of the \isible portion of the log, the log should automatically scroll to the bottom in order to display
the message. In certain situations, this was not happening.

The Pixel Editor was requiring unit IDs for LOR networks to be entered using their decimal value.
Now unit IDs are entered with their hex value, just like every other LOR program. Users of
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version 4.0.0 will need to go back into each prop thatison an LOR network and update
the unit ID to use the controller's hex value.

What's New in Version 4.0.0

Pro lewel license

The Light-O-Rama Pixel Editor

Intensity files

Enhanced Light-O-Rama networks

Speed improvement for converting channels to RGB channels

Fading images and text in and out in SuperStar

Visualizer now supports DMX RGB Pixel Universes

Visualizer now supports inserting Symbol Fixtures with more than 256 Vertices
Visualizer Wizard Updates

Improved Pixel Ordering Display in Visualizer Draw Window

Improved Visualizer performance while rendering

Improved Visualizer Error Messages

Improved Visualizer Shimmer and Twinkle Emulation

New SuperStar parameters windows in Visualizer for Fixtures & Props
Improvements for certain Comm Listener log messages

New and updated firmware

"4GB Patch" enabled by default

New LOR PIXCON16 E1.31 based controller

Cosmetic Control Panel changes
MP4 media files

Bug fixes

Pro Level License

There is now an additional license level, "Pro", above Advanced. A Pro lewel license enables several
new features designed to help with very large displays: The Light-O-Rama Pixel Editor, intensity
files, and enhanced Light-O-Rama networks.

The Light-O-Rama Pixel Editor

The Light-O-Rama Pixel Editor is a new program which can be used to produce lighting effects for
seguences in a visual way. It produces intensity files, which can efficiently support large lighting
displays.

Intensity Files

Intensity files are a new way to store lighting commands. An intensity file, generated by the Light-
O-Rama Pixel Editor or the Light-O-Rama SuperStar Sequencer, is associated with a sequence,
and will play at the same time that the associated sequence plays. Instead of storing lighting
commands in the traditional high-level way (such as "fade up over the next five seconds from 0% to
100%"), an intensity file stores large blocks of instantaneous intensity values for potentially many
circuits. This allows the intensity file to be very efficient during play, and so enables better support
for very large lighting displays.

Only Light-O-Rama controllers and native DMX devices can be used in an intensity file, and the
Light-O-Rama controllers must be on enhanced LOR networks. The LOR Comm Listener must be
running in order for the lights to be controlled. This feature only works under the Pro license level.
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Enhanced Light-O-Rama Networks

A Light-O-Rama network can now be set to be an "enhanced" network. This causes the network to
use a new communications protocol (an extension of the standard Light-O-Rama communications
protocol) which can deliver lighting commands for many channels efficiently. If an intensity file is
used, any LOR controllers from the intensity file must use an enhanced LOR network, but enhanced
LOR networks also support effects defined directly in a sequence.

The Hardware Utility can also write SD cards for G3 Directors for Enhanced Networks. Again, all
controllers connected to a port must support the Enhanced Protocol, and the G3 directors firmware
will need to be updated to at least version 5.32.

Not all Light-O-Rama controllers support the enhanced protocol, and some may require firmware
updates in order to do so. The LOR Comm Listener must be running in order for lights on an

enhanced network to be controlled when using a computer. Enhanced LOR Networks only work
under the Pro license level.

Speed Improvement for Converting Channels to RGB Channels

In the Sequence Editor, converting channels to RGB channels would get slower and slower as the
sequence got larger and larger, and eventually the sequence would become large enough that the

conwversion would take a very long time. This has been sped up significantly.
Fading Images and Text In and Out in SuperStar

You can now fade images and text in and out in SuperStar, using PreRamp and PostRamp times
(see here for images and here for text).

Visualizer now supports 'DMX RGB Pixel Universes'

The Visualizer now supports a ' DMX RGB Pixel Universe' fixture. This fixture allows for up to 170
RGB pixels to be part of a single fixture which is defined as a DMX Universe.

Visualizer now supports inserting Symbol Fixtures with more than 256 vertices

Previously the Visualizer was limited to creating a single fixture for a symbol. This limited the
selection of a font glyph to one that had less than 256 vertices. The Visualizer will now create a
prop and as many fixtures as needed for a single glyph, up to a maximum of approximately 16,000
vertices.

Visualizer Wizard Updates

e All drawing wizards that could previously be used with Cosmic Color Devices have been updated
to be able to use the new DMX Pixel Universe fixtures as well.

e A new wizard for drawing DMX Pixel Strings has been added.

e A new option for 'Snake' layouts has been added to the Matrix Wizard, as well as a new selection
that will show pixel ordering while the wizard is running.

¢ Maximums for the Tree, Arch, and Matrix wizards have all been increased. Trees and Arches can
now be up to 64 segments. A matrix can be either 64 pixels wide or high depending on the
orientation.
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Improved Pixel Ordering display in Visualizer Draw Window

Pressing SHIFT while pointing at a CCR or DMX Pixel Eixture in the drawing area will ‘blink’ the
pixels in the order they are assigned. The speed of the blink can be controlled in the The
Visualizer's Options window, Tab 2.

Improved Visualizer performance while rendering

A new advanced rendering engine has been added to the Visualizer to greatly enhance performance
of the program while simulating many channels, especially RGB bulbs. The new rendering engine
takes advantage of the hardware acceleration available on nearly all modern video cards. This new
engine is experimental, however it has been tested on seweral different cards. The new engine is
enabled by default, howewer it can be disabled if needed.

Improved Visualizer Error Messages

When entering simulation mode, the Visualizer would give cryptic error messages if it was unable to
assemble Cosmic Color Devices into meaningful groups. Those error messages have been improved
and expanded to include DMX Pixel Universes.

Improved Visualizer Shimmer and Twinkle emulation

The Visualizer will now more closely emulate how a real controller presents shimmers and twinkles.
Due to differences between actual hardware clock speed and the visualizer, slight differences will
remain, howewer the look is much improved over S3.

New SuperStar parameters windows in Visualizer for Fixtures and Props

A new dedicated window has been added to both Eixtures and Props in the Visualizer to store
SuperStar parameters. Previously, these parameters were placed as a keyword in the comments of
a fixture/prop. They now have a dedicated area for ease of use.

Improvements for certain Comm Listener log messages

Certain log messages that were output by the Comm Listener, associated with errors or other
information about TCP/IP sockets, would include in their output some numbers that were essentially
meaningless from the point of view of the end user. They now instead output the IP address and
port of the socket.

New and updated firmware
Several new and updated pieces of firmware have been released:

e CCB100D-V1 20.Ihx (CB100D Cosmic Color Pixel/Bulb Controller) : Added support for Enhanced
LOR networks, and fixed a bug where the bulb self test did not correctly run while the reset button
was held on the controller.

e CCR150D-V1 19.Ihx (CR150D Cosmic Color Ribbon): Added support for Enhanced LOR
networks.

e CMB24D-V1 _02.lhx (CMB24D): This is the first version of firmware for this device that has been
distributed with the LOR software suite.

e CTB04Dg3-V1 01.Ihx (the new 4 channel CTB04g3 AC controller; also used in the new
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LOR400Wg3 and LOR400ELLWg3 controllers).

e CTB08Dg3-V1 02.lhx (the CTB08Dg3 controller card and the LOR800Wg3 controller): Added
support for Enhanced LOR networks.

e CTB16PCg3-V1_08.lhx (the CTB16PCg3 card and the gen3 residential controllers): Added support
for Enhanced LOR networks.

e CTB32Lg3-V1_12.lhx (the CTB32L card and the LOR16xxWg3 light controllers). Added support
for Enhanced LOR networks.

e DC_MP3 _V4-20.lhx (DC-MP3): This version of the firmware makes triggered shows start faster.

e iDMX1000_V1_50.Ihx (the iDMX1000 controller). Fixed a problem with missed effects when
running at 115.4K. Added support for 500K. Added support for Enhanced LOR networks.

e MP3g3-V5_32.lhx (G3 MP3 Dual Network Director): Supports Enhanced LOR networks, and fixes
two bugs: (1) In some cases, the firmware would believe that the sound and lights were extremely
out of sync when they were not. This would cause error detection code to be triggered which
would stop the song that was playing and mowve on to the next song. (2) In some cases, the
firmware would ignore a show's schedule. Instead, a show would start as soon as the SD card
was inserted.

e RF-V4 \2-10.lhx (RF-V4 Easy Light Linker): This release allows the RF-V4 to use 115K comm
speed.

e UMP3g3-V5_32.lhx (G3 Mini Director): Supports Enhanced LOR networks, and fixes two bugs: (1)
In some cases, the firmware would believe that the sound and lights were extremely out of sync
when they were not. This would cause error detection code to be triggered which would stop the
song that was playing and move on to the next song. (2) In some cases, the firmware would
ignore a show's schedule. Instead, a show would start as soon as the SD card was inserted.

"4GB Patch" enabled by default

In recent times, many customers with very large sequences who have been running into memory-
related issues have been using a third-party tool known as the "4GB Patch" to modify the Sequence
Editor and Show Player executable files. The effect of this is that Windows will allow the patched
programs to use more memory than it would allow for the unpatched programs. Whenever a
customer using the 4GB Patch upgraded to a new version of Light-O-Rama, they would have to
remember to use the 4GB Patch on the new \ersions of the two executable files, or else they would
start running into memory-related issues again.

Now, though, the Light-O-Rama installer distributes the Sequence Editor and Show Player
executable files as if they had been patched using the 4GB Patch. Users therefore should no longer
need to run the 4GB Patch on these programs.

Just in case something unexpected occurs because of this, the installer also distributes unpatched
versions of the executables. The patched versions are what are used by default, without the user
needing to take any action. If for whatever reason you want to use the unpatched versions, though,
they can be found in the Light-O-Rama program files directory (which is typically, but not always,
either C:\Program Files\Light-O-Rama or C:\Program Files (x86)\Light-O-Rama). They are called
LORSequenceEditor-Unpatched.exe and LORMonitor-Unpatched.exe. To start using them, shut
down your running programs, then rename the default patched versions out of the way (for example,
rename LORSequenceEditor.exe to LORSequenceEditor-4GBPatched.exe), and then copy the
unpatched versions into their place (for example, copy LORSequenceEditor-Unpatched.exe to
LORSequenceEditor.exe).

The LOR PixConl16 E1.31 Controller

The LOR PixConl16 is the first E1.31 and newest controller offering from Light-O-Rama. The board
can control up to 16 170-pixel strings using various different chipsets, as well as be a bridge for 4
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separate DMX universes all running on Ethernet.

Cosmetic Control Panel Changes

The order of menu items in the LOR Control Panel's right-click popup menu has been changed so as
to hopefully more clearly group sets of similar items. Also, the Control Panel would say things like
"Light-O-Rama is Disabled" to mean that scheduled play of shows was not currently enabled; this
has been changed to the hopefully less confusing "Scheduled Play is Off".

MP4 Media Files

The Sequence Editor now allows MP4 files to be used as the media files for musical sequences.
Please note that not all such files will work on all computers; for example, a particular MP4 (or some
other type of media file) may be encrypted with DRM or may require a codec or filter that is not
present on the computer.

Bug Fixes

Using a Wizard other than the Channel Wizard could cause the Visualizer to leak resources.
When using the Arch Wizard, changing from Arch to Fan or vice-versa the minimum number of
segments was not being set correctly. This could lead to errors in the wizard which were caught
and dealt with, but which should not have occurred.

When using the Tree Wizard, the Pixels Per Segment spin control did not accelerate the longer
the user pressed the up/down buttons.

The Matrix Wizard was generating errors whenever the form was re-sized. This lead to errors in
the wizard which were caught and dealt with, but which should not have occurred.

Deleting a Prop did not always remove the Prop's definition from the program. In essence, a prop
with no fixtures was saved/loaded each time. Any prop that is deleted now also deletes the prop's
definition.

If a sequence file could not be loaded due to an invalid end centisecond for one of its effect events,
the Sequence Editor would issue an error message mistakenly quoting the event's start
centisecond instead of its end centisecond.

Some memory leaks (in various programs) associated with interacting with the Windows shell
have been fixed. Most of these seem unlikely to have actually caused memory to leak in practice,
but in theory they might have. One would definitely cause memory to leak in practice, but a
relatively small amount.

When the LOR Verifier was checking for warning 32 ("Channel in tracks of conflicting length"), it
would display its progress percentage incorrectly, sometimes even displaying progress above
100%.

The Simple Show Builder and the MP3 tab of the Hardware Utility would incorrectly allow for more
than 99 sequences to be added to a show. Hardware Directors can only handle a maximum of 99
sequences in a single show.

The Network Preferences program was not correctly deleting old versions of the network
configuration from the registry. This was due to a recent change in how Microsoft allows access
to the registry.

In the Visualizer, when simulating devices with Unit IDs greater than 100 (hex 64), a channel could
be incorrectly activated on a different channel on the next higher network.

The Network Preferences program could incorrectly flag two ports as being in conflict even if they
were not. If the ports were in conflict, there was also a chance that the incorrect ports/adapters
were reported.

The_Network Preferences program could experience unintended behavior if the column header in
any of the list displays were clicked.

If the Sequence Editor or Show Player stopped while a sequence was playing, any DMX lights
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that happened to be on at that time would remain on indefinitely.
What's New in Version 3.12.2

e New SuperStar license level: 60 CCR
New SuperStar license level: 60 CCR

SuperStar now supports a new license level for up to 60 CCRs. The highest previously existing
license lewvel supported up to 40.

What's New in Version 3.12.0

e MP3g3 Directors can now output to DMX devices

e MP3 File Loading Speed Improvements for MP3 Directors

¢ New MP3g3 Show Time Director Firmware

¢ |nitial firmware for Single Network Mini MP3 Director

¢ Improvements for busy sequences being run on MP3 Directors
¢ New Options and Features in SuperStar Instant Sequencing

e New Pre-ramp and Post-ramp options for SuperStar images

e New SuperStar Morph Option

e New Wrapped Tree for SuperStar
e Bug Fixes

MP3g3 Directors can now output to DMX devices

MP3g3 Directors can now output to both LOR, DMX, or a combination of the two devices. All the
devices must be the same on a particular port, but a particular port can run LOR or DMX devices

now. You must use the Hardware Utility to write the sequence to the SD card, and the MP3g3
director must be updated to version 5.28 of the firmware.

MP3 File Loading Speed Improvements for MP3 Directors

The Hardware Utility can now optionally strip unnecessary header information from an MP3 while
creating an SD card, improving sequence loading speed on MP3 directors.

New MP3g3 Show Time Director Firmware

A new version of the firmware for the MP3g3 Show Time Director, MP3g3-V5_28.Ihx, allows for the
use of DMX or LOR devices on a port.

Initial firmware for Single Network Mini MP3 Director

The initial version of firmware for the Single Network Mini MP3 Director, uMP3g3-Vv5_28.1hx, has been
released. This version of firmware supports both LOR and DMX512 output (DMX512 output requires
version 3.12.0 of the Hardware Utility).

Even though this is the first release of firmware for this particular device, the version number is 5.28

so as to keep in sync with the version number of the Dual Network ShowTime MP3 Director (MP3g3-
V5_28.1hx).
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Improvements for Busy Sequences Being Run on MP3 Directors
The Hardware Utility and the Simple Show Builder will now throttle busy sequences so that they
better stay in sync with audio. Once the bandwidth of a port on an MP3 director is exceeded, the
amount of sequence data written to the card is reduced until the director can catch back up with the
sequence. Previously MP3 directors would continue to send all data out the port, regardless of the
bandwidth available. During particularly busy sequences, the director would fall back further and
further. Once a sequence falls behind now, all subsequent commands are discarded until the
director finishes sending the queued data.

New Options and Features in SuperStar Instant Sequencing

The SuperStar Instant Sequencer now has new options including new custom colors, new
movement options, and a new trigger type.

New 'Pre-ramp' and 'Post-ramp’ options for SuperStar Images
The user can now specify pre and post ramp options when using images in the SuperStar editor.
New Superstar Morph Option
The user now has the option to not shrink a visualization when doing a morph.
New 'Wrapped Tree' for SuperStar
The Superstart Sequencer now can use Wrapped Trees in Visualization sequences.
Bug Fixes

¢ In the Hardware Utility when creating an SD card for an MP3 Director that used triggers,
immediately trying to create another show using a different trigger could overwrite the wrong show

number.
e The Hardware Utility incorrectly identified the CCB100D as having stand-alone capability. It does
not.

¢ |f SuperStar was in Visualization mode and a smooth effect color is set to white, if the color is
changed to something that is not white, the bar in the time layers would stay white.

e |f SuperStar was in Visualization wrap around mode and also in scene mode there were cases
where the first pixel turns black with a yellow border.

e |f SuperStar was in Visualization wrap around mode sometimes only the left half would have pixels
set.

¢ In some cases, SuperStar could create instant sequences that go beyond the end of a song. This
is caused issues since the Sequence Editor fails to play the exported sequence if there are
effects that go beyond the end of the song.

¢ In some cases, SuperStar would crash when creating a Quick Visualization.

¢ In SuperStar, when opening an .sup file the Instant Sequence settings were being cleared.

¢ In SuperStar, if a fixture was multi-color and had no channels assigned it was still being drawn as
if it were active.

¢ In SuperStar non-CCR strings would sometimes display in dark gray on the screen when clicking
on the "VisEffect" checkbox.

e For SuperStar, increased the maximum value of the Sequencing Grid Max Length from 200 to 360
in the Import Visualization dialog box,

e For SuperStar, changed the valid range of morphs to be -50 to 360.
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¢ In some instances, SuperStar was not checking the length of the row it was sequencing.

e For SuperStar the limit of Maximum Detection lines was increased from 24 to 36 in the Import
Visualization dialog box.

¢ In SuperStar if the user clicked twice very quickly on the Play or Play All button, the program
Beeped, played and then crashed at the end of the Play.

¢ |n SuperStar, if in Visualization mode and a smooth effect color was set to white, and then the
color was changed to something that is not white, the bar in the time layers would stay white.

What's New in Version 3.11.2

Changes to Edit menu keyboard shortcuts

Verifier checks for old MC-P_compatibility mode

Optional speed improvements for saving in the Sequence Editor
Manual creation of compressed sequences

e Bug fixes

Changes to Edit Menu Keyboard Shortcuts

The menu items Undo Settings and Use Internal Media in the Sequence Editor's Edit menu did not
have shortcut keys assigned to them. To give them shortcut keys, the menu items "Turn on Loops"
and "Select" were changed to "Turn on Loop Lewels" and "Select Zone", which allowed them to be
mowved to the shortcut keys "V' and "z", thus freeing up "s" and "|" for Undo Settings and Use
Internal Media, respectively.

Verifier Checks for Old MC-P Compatibility Mode

The Verifier now checks to see whether old MC-P_compatibility mode has been enabled. This
compatibility mode is required for certain controllers, but they are rare, and if it is enabled, it can
cause significant overhead on your network. The Verifier therefore warns you if it detects that this
mode is enabled.

Optional Speed Improvements for Saving in the Sequence Editor

When the Sequence Editor saves a sequence, it actually saves it to a temporary file first, and then
attempts to reload that temporary file. Only if the load is successful will it actually overwrite the
existing "real" sequence file with the newly saved temporary one. This is intended to minimize the
potential for a save where something went wrong to cause the user to lose a good (earlier) save.
This behavior is now optional, via the Verify Load option in the Saving Preferences menu. It is still
recommended to have this behavior enabled, but if you work with very large sequences that take
significant amounts of time to load and save, and are willing to take the risk of a corrupted save
overwriting your previous good save file, you might want to turn it off in order to speed up saving.

The Sequence Editor also creates a compressed sequence whenever it saves a sequence, but you
can now optionally disable this behavior via the Export Compressed option in the Saving Preferences
menu. Again, it is still recommended to have this behavior enabled, but if you work with very large
sequences that take significant amounts of time to save, you might want to turn it off in order to
speed up saving. If you do choose to turn it off, it is highly recommended that you manually ensure
that your sequences each have an up-to-date compressed sequence before starting your show. You
can do so via the Export as Compressed command from the Eile menu.

Manual Creation of Compressed Sequences
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By default, the Sequence Editor creates a compressed sequence whenewer it saves a sequence, but
this behavior can be disabled via the Export Compressed option in the Saving Preferences menu. If
you choose to disable that option, it is highly recommended that you manually ensure sure that your
sequences each have up-to-date compressed sequences before starting your show. You can now
manually create a compressed sequence for a single sequence Via the new Export as Compressed
menu item on the Eile menu, or manually create compressed sequences for a show or for the entire
schedule via the Sequence Compressor program.

Bug

Fixes

The LOR Verifier would incorrectly report that three files (AdjiMmsEng.dll, amp3dj.ocx, and
Asoedmms.ocx) had unexpected version numbers.

SuperStar's Play 8 Seconds and Play All buttons were not staying depressed when used in
visualization mode, and the other buttons were not being grayed out.

SuperStar's Configuration dialog box will now give a message if the range of unit IDs for a network
is invalid.

In SuperStar, if the row visualization had a fixture that was not in the real visualization, it
sometimes would not get reported as a warning.

If you modified a morph in SuperStar and then played a part of the sequence, the start and end
coordinates of the morph would get set to -1 after stopping play of the sequence.

SuperStar might have crashed if you put a smooth effect in the right half of a Msualization that was
in wrap around mode.

SuperStar might have crashed when playing a shockwave effect using a visualization in wrap
around mode, especially if the shockwave had a large leading or trailing edge.

Various Light-O-Rama programs used to depend upon the Microsoft library "SCRRUN.DLL". If
this library was missing or misconfigured, various strange problems would occur. An example is
that keyboard maps would not function in the Sequence Editor. In recent times, this library
seems to be missing or misconfigured more and more frequently on customers' computers, and
so Light-O-Rama no longer depends upon this library.

SuperStar now checks in the Configuration dialog box to make sure that entries for the star unit
ID, first CCR unit ID, and the ranges of the networks are all valid.

If Windows had been running for about 25 days or more without having been shut down, the
Hardware Utility would sometimes not be able to write the time to an SD card.

What's New in Version 3.11.0

Cosmic Color Array support

Channel priority

Named timing grids kept even if empty and not in use

New card and controller support in the Hardware Utility
Easy Light Linker configuration change

SuperStar font update

SuperStar CCR string segments increase

Sequences can be removed from the Recent Sequences list
Paste options mowved to their own portion of the Tools Panel
Memory and speed improvements for sequences

Control over number of recorded undo items

Changing input types with InputPup devices

New MP3g3 Show Time Director firmware

New CTB32LD/LOR160xWg3 firmware

Bug fixes
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Cosmic Color Array Support

Cosmic Color Arrays are now supported in the Sequence Editor, via the Insert Device dialog and
also in channel grouping.

Channel Priority

In most cases, if two lighting effects for two different channels on the same controller are supposed
to happen at the same time, it does not matter which of the two commands is sent to the controller
first. Howewer, in some cases, it does matter: For example, a macro command for a Cosmic Color
Device should be sent before a command for a regular channel on that CCD (presuming the two
commands are supposed to take effect at the same time). In the past, this was determined based
upon the circuit number of each channel. However, with the introduction of Cosmic Color Arrays,
this is no longer possible, as their special channels use different circuit numbers than the special
channels of other CCDs. So, the concept of "channel priority" has been added, to explicitly set
which channels take priority over which others. Please note: If you have created a Cosmic Color
Device (or Array) channel group in the sequence, channels within that group will automatically have
their priorities set appropriately. You only need to manually set the priority yourself if you have not
included those channels in a CCD/CCA channel group in the sequence.

Named Timing Grids Kept Even If Empty and Not In Use

Previously in the Sequence Editor, if you changed which timing grid a track was using, and the old
timing grid was empty (i.e. had no timings) and was not in use by any other track, that old timing
grid would be discarded. This is now only done if, additionally, that old timing grid does not have a

name.

New Card and Controller Support in the Hardware Utility

The Hardware Utility now recognizes the CTB08Dg3 card, and the LOR800W which uses that card.

Easy Light Linker Configuration Change

Easy Light Linker (ELL) configuration has been changed in the Hardware Utility: Support was added
for the new LOR-RF-V5, which supports 115200 kbps. Also, previously, the LOR-RF-V4 only
supported speeds up to 57600, but with the introduction of the LOR-RF-V5, there will be a new
release of firmware for the LOR-RF-V4 that will enable it to run at 115200 as well.

SuperStar Font Update
Several of SuperStar's fonts have been updated:

6-6x6_Thin_Vertical.system.font
8-8x8_Thin_Vertical.system.font
10-12x12_Bold_Vertical.system.font
10-12x12_Thin_Vertical.system.font

SuperStar CCR String Segments Increase

The number of CCR string segments that can be used in an imported visualization in SuperStar has
been increased from 124 to 160.
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Sequences Can Be Removed from the Recent Sequences List

Sequences can be removed from the Sequence Editor's Recent Sequences list. To do so, right-
click on the file you wish to remowe, and a popup menu will open. The menu will have an entry to
remove the file from the list.

Paste Options Moved to Their Own Portion of the Tools Panel

The Clipboards subpanel of the Tools Panel in the Sequence Editor used to contain controls for both
clipboards and for paste options. The paste options have now been mowed to their own subpanel.
This will hopefully make them a little easier to get at when many clipboards are present, by
collapsing the Clipboards subpanel.

Memory and Speed Improvements for Sequences

Various memory and speed improvements related to sequences have been made. For example, one
particular very large sequence which took about 2 minutes 15 seconds to load, consuming about
420 MB of memory, now takes about a minute and a half and about 160 MB.

Control Over Number of Recorded Undo ltems

The Sequence Editor only remembers a certain number of changes (per sequence) for undoing and
redoing. This number can now be changed, via the Undo Settings dialog. For most users, the
default value will be fine, but users with large sequences who make large changes to those
sequences might want to place a smaller limit on the number of remembered changes so as to help
awoid running into memory-related issues.

Changing Input Types with InputPup Devices

The Hardware Utility will now allow changing input types (NO/NC) with InputPup devices.

New MP3g3 Show Time Director Firmware

A new version of the firmware for the MP3g3 Show Time Director, MP3g3-V5_25.Ihx, fixes a bug
where animation sequences (non-musical sequences) would not run if two networks were specified
in the file.

New CTB32LD/LOR160xWg3 Firmware

A new version of the firmware for CTB32LD/LOR160xWg3 controllers, CTB32LG3-V1_12.lhx, fixes a
bug where most standalone sequences would not operate properly.

Bug Fixes

¢ In the Hardware Utility, sometimes the ELL icon would show up when an MP3 director was
connected but no ELL was on the network.

e Smooth effects in SuperStar would not export beyond 4 minutes 21 seconds of a song.

e The LOR Verifier would report an "error 7" on the file "audioconv.ocx", meaning that the file was
missing. This is because the file is no longer used by the current version of Light-O-Rama
software, and therefore is no longer distributed. That check has now been replaced with checks
for new libraries used by the current version of software.

¢ In SuperStar's Visualization mode, the Pixel Resolution macro was not being supported for
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auxiliary networks.

On some computers, SuperStar would have a repaint problem that would happen when you
replayed a sequence to the computer screen.

Import visualization in SuperStar had various issues relating to mapping lights to the sequencing
grid.

Text with a ramp in SuperStar could create channel commands for channel 151 when exported,
resulting in white flashes on the CCR.

In SuperStar, the selection rectangle would not get drawn around text actions that had a trailing
ramp.

SuperStar would crash when saving a file with a very large image.

Only one star could be set when applying a star scene in SuperStar.

If you had more than one sequence open in the Sequence Editor, and they were not maximized
(with respect to the Sequence Editor itself, as opposed to with respect to the screen), and you
attempted to close them via their "X' buttons, the last one would not close.

Musical sequences are not allowed to have loop lewvels, but the Sequence Editor would allow you
to add a media file to an animation sequence that had loop lewels, which would lead to various
issues. Now the Sequence Editor will offer to remowve the loop levels, and will not add the media
file unless the loop levels are remowed.

In SuperStar, selecting or moving an effect in the time layers in a large sequence could take 30
seconds or more and cause the program to appear to crash.

If you moved two smooth effects that have the same start time up or down a layer in SuperStar,
one of them could disappear.

If you tried to use a sequence containing a loop that looped back more than 255 times as a
standalone sequence, the Hardware Utility would refuse, giving a not-too-helpful error message
that merely said "Owerflow". The Hardware Utility will still refuse, but it will now give an error
message that is, hopefully, more helpful.

There could be a flicker at the end of the tail on a MisEffect. The flicker would only be seen in the
exported file.

Moving endpoints of a group of morphs in SuperStar wouldn't move to the upper sequencing rows if
using half ribbons in CCR mode.

A light in a QuickVis visualization would fail to draw if the QuickVis was large and had to be
shrunk to fit on the SuperStar screen.

What's New in Version 3.10.14

Bug fixes

Bug Fixes

The Sequence Editor could sometimes report that a media file is not present when in fact it is
present. This could cause an error within the Sequence Editor or any of its tools. This problem
usually manifested itself when adding a track to a new sequence. However, any part of the
Sequence Editor that requires media could also have had this issue.

CCRs laid end to end horizontally did not import properly in SuperStar.

SuperStar would crash on some computers if the first effect in a sequence was the smallest star
in the SuperStar star.

When modifying a text mask in SuperStar, it would always display an error.

In SuperStar, visualizations with draw objects that have the same unit ID would display the square
in the sequencing grid as disabled, and instant sequence would not properly define effects to the
row.

A matrix of CCR props would sometimes not import in the proper order in SuperStar.

© 2017 Light-O-Rama, Inc.



What's New? 75

What's New in Version 3.10.12

e Bug fixes

Bug Fixes

Text and images sometimes would not clip properly when played to a visualization in SuperStar.
Some visualizations would not import properly in SuperStar.

What's New in Version 3.10.10

¢ Help file available in EPUB format
e Bug fixes

Help File Available in EPUB Format

An EPUB (e-book) version of the Light-O-Rama help file is now available, and is published along with
the installer as well as on the Light-O-Rama website.

Bug Fixes

Importing a prop into a visualization that was empty (that is, which had no fixtures) would cause
the object selection area to disappear from the Visualizer.

If Play Again was used in the Sequence Editor before Play (without "Again") had ever been used,
play would hang.

If a large sequence with a ribbon located at the bottom was exported, SuperStar would crash.

If SuperStar was launched into CCR mode, the "star in use" setting would get set to "no", and the
star channels would get played to ribbons, and you wouldn't be able to add star channel effects
either.

Visualization errors in SuperStar no longer get reported at launch if you are in CCR mode. Also,
visualization file errors are not reported when loading a CCR mode sequence.

Some dialog boxes in SuperStar would allow the start time of an effect to be after the end time.

What's New in Version 3.10.8

New device in Insert Device: CMB24D

Continued improvements to media handling
VisEffects

Import Visualization Pair

"Reverse" keyword for pixel layout in CCR fixtures
"Myorder" keyword for order of fixtures

Bug fixes

New Device in Insert Device: CMB24D

The Insert Device dialog of the Sequence Editor now supports an additional device: The CMB24D. It
is a 24 channel controller; you can tell the Insert Device dialog to treat it either as 24 channels or as

8 RGB channels.

Continued Improvements to Media Handling
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The Sequence Editor will continue to attempt to create two different internal media formats, for
different purposes. However, should one of those conversions fail, the Sequence Editor will no
longer refuse to create or open a sequence. Instead, the user is simply informed that one or both of
the conwersions failed. The Sequence Editor will then choose the best file to use for whatever
purpose based upon which of the three files exists and/or the user-specified options. If a format that
is required for a particular use could not be created, that use will simply not be available. For
example, the Beat Wizard requires that a particular internal media file be created; if it could not be
created for a particular sequence, then the Beat Wizard cannot be used for that sequence, and a
warning will be presented if you attempt to use it.

A new option, Use Internal Media, has been added to the Edit menu. This option is set per
sequence and is saved when the sequence is sawved. It allows you to control whether or not Light-O-
Rama attempts to use the internal formats with the sequence. It is recommended that this option
be on. The option defaults to being on, except when a sequence created using an earlier version of
Light-O-Rama is loaded (so that media handling behaves for these sequences as it did in earlier
versions, unless you choose otherwise). More details can be found at "Use Internal Media".

VisEffects
SuperStar now supports "visEffects". This gives the ability to apply morphs to the visualization

instead of to the sequencing grid, and allows a smooth coordinated sweep across all the lights in
the visualization.

Import Visualization Pair
You can now import a pair of visualizations into SuperStar, as a "Row Visualization" and a "Real
Visualization". The Row Visualization is to be laid out in rows according to how you want the lights
mapped to the sequencing grid. The Real Visualization should be laid out how the light display

actually appears.

"Reverse" Keyword for Pixel Layout in CCR Fixtures

SuperStar now supports a hew keyword, "reverse”, for the layout of pixels in a CCR fixture.

"Myorder" Keyword for Order of Fixtures

SuperStar now supports a new keyword, "myorder", controlling the order of fixtures.
Bug Fixes

e Musical sequences whose media files had names that included multiple consecutive periods
(such as "1983... (A Merman | Should Turn To Be).mp3") would not successfully play.

¢ In SuperStar, if you clicked on an effect in one of the effect lists and then hit play, the effects
wouldn't get rebuilt and played for the new location you are at.

¢ The movement and color of instant sequence effects in SuperStar would get reinitialized every 10
seconds.

e The grid setting and star in use setting could change when changing between SuperStar's CCR
mode and Visualization mode.

e After changing from SuperStar's Visualization mode to CCR mode, you could not add a scene to
the star.

e Export of large sequences could cause SuperStar to crash.

e On some computers with older versions of Windows Media Player, no matter what play speed
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was selected in the Sequence Editor, the sequence would always play at normal speed.

¢ In SuperStar, rendering a fast rotating fan with thin blades would play fine on the computer screen,
but would export as a dot.

¢ In SuperStar, a fan longer than ten seconds would play fine on the computer screen, but when
exported would last less than ten seconds.

e |f a soundboard interactive group were set up in a show, and contained a single sequence on a
particular trigger, and that trigger were tripped while that sequence was playing, an error message
would occur ("ERROR STARTING SEQUENCE (This key is already associated with an element of
this collection)"). The sequence would not start, and could no longer be started during the current
run of the show.

e Text masks in SuperStar were not working for imported visualizations using a matrix made up of
fixtures.

e SuperStar's smooth effects would not play to white mono-color lights.

e Shimmers produced in SuperStar would not stay the same color while shimmering.

e |f a CCR with no assigned base unit is in an imported visualization, SuperStar will issue a warning.

e You can now open a file in SuperStar by double clicking on the file in Windows. Previously,
SuperStar would crash while attempting to open the file if you did this.

¢ |n an imported visualization in SuperStar, props of two or three fixtures would be in reverse order.

¢ In an imported Visualization in SuperStar, the trailing ramp of an image would not clip the maxrix
CCRs.

What's New in Version 3.10.6

e Bug fixes
Bug Fixes

e |f you exported a sequence from SuperStar, and then opened that sequence in the Sequence
Editor, made a change to it, and saved it, the Sequence Editor would warn you that the sequence
was created by an older version of Light-O-Rama.

e |f SuperStar were already in Msualization mode, and you opened a .SUP file that referenced a
visualization file that did not exist, SuperStar could crash.

What's New in Version 3.10.4

e Additional networks in SuperStar
e Bug fixes

Additional Networks in SuperStar

The number of networks in CCR mode in SuperStar has been increased from 4 to 8. Note that in
Visualization mode, you can have the full 16 networks.

Bug Fixes
¢ A fast double click in the object selection area could lock up the Visualizer.

¢ In SuperStar, if the "white" color control is nonzero, and you scroll some text or images using a
visualization, the text or image in the exported sequence could skip and jump in some cases.

What's New in Version 3.10.2
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Bug

Bug fixes
Fixes

In SuperStar, the clipboard could not be saved to a file.

The Sequence Editor would sometimes give an "invalid procedure call or argument™” error when
attempting to save a sequence.

The Sequence Editor would have problems with MIDI files, most prominently being unable to
create new musical sequences based on MIDI files.

Sometimes an imported visualization in SuperStar would get resized too large, and its bottom
would get chopped off.

What's New in Version 3.10.0

Sorting in the Keyboard Preferences dialog

Copy and Print in the Keyboard Preferences dialog

Better memory usage in SuperStar

New and updated fonts in SuperStar

Updated SuperStar visualizations

Eight channel Gen3 controller support in Hardware Utility
Improved network detection in the Visualizer

LOR Control Panel can restart the Show Player

Show Player can automatically shut down and restart in certain situations
Show Player will decache sequences if memory usage is too high
Visualizer Keywords in SuperStar

Duplicate RGB channel assignment warning in SuperStar

More DMX adapters supported

LOR Diagnostic shows more information

Copy and sawe in LOR Diagnostic

Beat Wizard, VU Wizard and Waveform Display support more media types
Better support for variable bit rate MP3s

Optionally play only audio while sequencing a video sequence
Show entire head at start of morph

Acceleration for morphs

Smooth effects in SuperStar

Support for more (and less) channels in the Hardware Utility
Firmware updates

Extend length of effects in instant sequence

Instant sequence and timing map dialog settings saved

Bug fixes

Sorting in the Keyboard Preferences Dialog

The Keyboard Preferences dialog in the Sequence Editor would previously display the list of
keyboard preferences in order of the keys - for example, an entry associated with the A key would
be listed before an entry associated with the B key. Now, the list can be sorted either in that order
or in order of operation - for example, an entry that causes the "Apply Fade Down" operation to be
performed would be listed before an entry that causes the "Copy Timing" operation to be performed.

Copy and Print in the Keyboard Preferences Dialog

In the Sequence Editor's Keyboard Preferences dialog, there are now new buttons to copy the list of
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keyboard preferences to the Windows text clipboard and to print the list.
Better Memory Usage in SuperStar

When building a sequence, SuperStar now uses about half as much memory as it used to.
New and Updated Fonts in SuperStar

Five new vertical fonts were added to SuperStar, and two fonts were updated with new asterisk
characters. The new fonts are:

6-5x6_Thin_Vertical.system.font
6-6x6_Thin_Vertical.system.font
8-8x8_Thin_Vertical.system.font
10-12x12_Bold_Vertical.system.font
10-12x12_Thin_Vertical.system.font

And the updated fonts are:

e 10-12x12_Thin.custom.font
¢ 10-12x12_Thin.system.font

Updated SuperStar Visualizations

Two sample visualization files for SuperStar, SuperStar_ControllersBottomLetft.lee and
SuperStar_ControllersTopLetft.lee, have been updated.

Eight Channel Gen3 Controller Support in Hardware Utility

The Hardware Utility's Advanced Configuration screen used to support only 16 or 32 channel
controllers. It now also supports 8 channel Gen3 controllers.

Improved Network Detection in the Visualizer

On a very limited number of machines, the Visualizer would be unable to detect the available
network adapters. If the detection fails, an alternate method is now used.

LOR Control Panel Can Restart the Show Player

In previous versions of Light-O-Rama, if the schedule was enabled but the Show Player was not
running (for example, if it were stopped via Windows Task Manager), the LOR Control Panel would
simply change so that the schedule was disabled. Now, it will instead attempt to restart the Show
Player. This may also help get the show running again more quickly if the Show Player crashes,
but not necessarily: In at least some cases the Show Player might still be "running” in a technical
sense until the user dismisses a Windows message box saying that the Show Player had crashed.

Show Player Can Automatically Shut Down and Restart in Certain Situations

If no show is playing, and if no show is scheduled to start playing within the next sixty seconds, and
the Show Player is using over a hundred megabytes of memory (commit charge size), it will
automatically shut itself down (and will then be automatically restarted by the LOR Control Panel,
assuming the schedule is still enabled). The intention of this is a preventive measure to protect

© 2017 Light-O-Rama, Inc.



Light-O-Rama v5.0.14

against ill effects of possible memory leaks in the Show Player, which could otherwise build up over
time to a point that would cause the Show Player to crash.

This behavior can be disabled (so that the Show Player will never shut itself down automatically) by
unchecking "Show Player Memory Restarts" in the LOR Control Panel's right-click popup menu.

Show Player Will Decache Sequences If Memory Usage Is Too High

During a show, whenever a sequence is about to start, the Show Player checks how much memory
(commit charge size) it is using. If it is using over a gigabyte of memory, it will attempt to reduce
memory usage by decaching sequences that it has previously loaded, until it drops down below 900
megabytes (or until it has no more sequences which it can decache). This is so as to prevent it
from caching more and more sequences until it finally runs out of memory and crashes.

If it winds up needing to play one of the decached sequences again, this means that it will have to
reload that sequence. Therefore, the sequences are decached in an order intended to minimize
loading time:

1. If a sequence is currently playing, it will not be decached.

2. If the Show Player knows for sure that a sequence is about to be played, it will not be
decached. Please note, though, that the Show Player may not always know for sure that a
sequence is about to play, even if you know it, and so in certain situations you may
occasionally see a sequence be decached soon before being played.

3. Sequences that are in sections of the show that are already finished are considered highly
decacheable, and will be decached before any other sequences. For example, if the
Shutdown section of the show is playing, then any sequences in the Musical or Animation
sections are considered very decacheable, since they will never be played again during this
run of the show.

4. Compressed sequences are considered more decacheable than non-compressed sequences,
since compressed sequences can be loaded much more quickly than non-compressed
sequences.

5. Two compressed sequences, or two non-compressed sequences, are compared to each
other based upon the number of times that they have been played and the amount of memory
that they took to load. Generally speaking, all else equal, a smaller sequence is more
decacheable than a larger sequence, since it can be loaded more quickly. Howewer, for any
specific pair of sequences, the larger might be decacheable if the smaller sequence were
played sufficiently more often.

Visualizer Keywords in SuperStar

You can now control various behaviors of how SuperStar will import a visualization by putting certain
keywords in the comments areas of props or fixtures in the visualization. For example, you can
mark a prop in the Visualizer so that when SuperStar imports the visualization, it will put the prop's
lights in certain specific locations in the sequencing grid.

Duplicate RGB Channel Assignment Warning in SuperStar

If you have RGB lights with duplicate channel assignments in an imported visualization, SuperStar
will warn you.
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More DMX Adapters Supported

Two more DMX adapters, the DMXKing UltraDMX Micro and the DMXKing UltraDMX RDM Pro, have
been added to the list of supported DMX adapters. Both should be configured in LOR Netwaork
Preferences to use the "ENTTEC DMX USB Pro" protocol.

LOR Diagnostic Shows More Information

In the past, LOR Diagnostic would display certain specific entries from the Light-O-Rama portion of
the Windows registry. If Light-O-Rama started using a new registry entry, and LOR Diagnostic was
not updated to include it, the information simply wouldn't be displayed at all. It now still shows
those specific entries, but also shows raw data from the entire LOR portion of the registry, so that
the information is present even if LOR Diagnostic is not specifically updated to include it.

Copy and Save in LOR Diagnostic

The LOR Diagnostic utility now has buttons enabling you to copy the utility's output to the Windows
clipboard or to sawe it to a file.

Beat Wizard, VU Wizard, and Waveform Display Support More Media Types

The Sequence Editor's Beat Wizard, VU Wizard, and Waveform Display now support more media
types, including video files. It also now has better support for the types that it supported in the past
- for example, they would be unable to handle certain MP3s, issuing an error message such as
"Cannot init conversion"”.

Better Support for Variable Bit Rate MP3s

In past versions, if your musical sequence used a variable bit rate MP3, and you wanted to use
certain features in the Sequence Editor (such as starting play somewhere in the middle of the
seguence instead of at the natural start of the sequence), you would need to convert the MP3 to use
a constant bit rate (using a third party audio editor such as Audacity), or it would not work properly.
Now, you may be able to do this without converting to a constant bit rate. Note that it's possible
that you may still have to conwvert in some cases, so keep tools like Audacity in mind just in case.

Optionally Play Only Audio when Sequencing a Video Sequence

The Sequence Editor's Video Preferences dialog now has an option which can be used to make the

Sequence Editor play only the audio track of a video file in a musical sequence, as opposed to also
showing the actual video.

Show Entire Head at Start of Morph
In SuperStar, there is now an option to show the entire head at the start of a morph. This can be
used, for example, to have a morph start out 50 pixels long, and get progressively shorter until it

disappears at the end.

Acceleration for Morphs

In SuperStar, morphs can now be set up to accelerate (or decelerate). This can be used, for
example, to make a morph going up that slows down, or a morph going down that speeds up, as if
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under the influence of gravity.
Smooth Effects in SuperStar
SuperStar now has three "Smooth Effects": Shockwave, Spiral, and Fan.
Support for More (and Less) Channels in the Hardware Utility
The main test screen of the Hardware Utility now supports 32 channels, rather than 16 as in the

past. This allows the use of this screen (rather than the console) to test the DIO32 (in native
address mode) and the new CMB24D (which is a 24 channel Direct Current (DC) card).

The advanced configuration screen previously only supported 16 and 32 channel cards. It has been
updated to support the new CTB08Dg3, an eight channel card.

Firmware Updates
Sevweral new firmware updates are included:

CCB100D-V1_16.Ihx
CCR150D-V1_17.Ihx
CTB16PG3-V1 _07.Ihx
CTB32LG3-V1_11.LHX
DIO32_V1-32.LHX
mDC_MP3_V4-22.Ihx

The CCB100D and CCR150D firmware includes additional support for 500K. The CTB16PG3 and
CTB32LG3 firmware includes support for "noisy AC" (less chance of flicker on noisy power). The
DIO32 and mDC_MP3 firmware contain many changes that have previously been posted online, but
never before distributed with the software installer.

Extend Length of Effects in Instant Sequence

SuperStar now has an additional option for instant sequences: "Extend Length of Effects". This
option will extend the length of each effect up to the start of the next effect. This makes the instant

sequence less "blinky".
Instant Sequence and Timing Dialog Settings Saved

SuperStar now saves the settings used in the Instant Sequence and Timing Map dialog boxes.
Bug Fixes

¢ In SuperStar, if you created a sequence in Instant Sequence, then clicked on "roll dice" and
"sequence all", it would not erase the existing sequence before creating the next sequence. You
would end up with multiple sequences stacked on top of each other.

e Some memory leaks related to sequences have been fixed.

¢ |f you attempted to add an effect in visualization mode in SuperStar, and the fixtures involved did
not contain any of the colors in the effect, an error would be displayed and you would not be
allowed to add the effect. This error would prevent you from using group modify to mowe pixels on
scenes. This error has been changed to a warning, and you are allowed to proceed if you want.

¢ After moving a selected group of effects in SuperStar, the first active selection could have been
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mowved. This would result in group modify thinking that some attributes had been changed when
they had not.

¢ In SuperStar's Import Visualization dialog box, if you type a value for "max length" and then click
OK, it would not use the value that you had typed in.

e |f you add a prop in SuperStar with a row and column specified, and then add a prop without a row
and column specified, it would use the row and column of the first prop for both props.

e A memory leak in SuperStar, related to the conversion of an MP3 to a WAV file, has been fixed.

¢ Non-CCR RGB strings would not process correctly in SuperStar if there were more than 48 pixels.

e |f SuperStar's sequencing row max length was more than 50, and if the total number of 50 pixel
CCRs was more than 24, it would make the sequence row count be 24.

e |f SuperStar's sequencing row max length was more than 50, the location of the SuperStar star
was not being calculated properly.

e The time progress display while SuperStar was playing a sequence would flicker.

e [ftwo channel commands owverlapped in SuperStar, the channel would play differently in SuperStar
than it would in the exported sequence.

e [f the SuperStar fonts directory contained more than twelve fonts, SuperStar would hang.

e [f the text in a SuperStar text action contained a double quote character ("), everything after that
character would disappear when you saved the .sup file and reloaded it.

¢ |f no method returns an available network adapter for the Visualizer, the "Local Loopback" adapter
is automatically used.

e When writing a show to an SD card via the Hardware Utility, you could type in the dropdown box

which is supposed to allow you to select the show number. Doing so would cause the show
number to be 0.

e The "cleanup sequence" in the Musical section of a show was not paying attention to the Musical
section's "Turn used lights off at the end of each sequence" option. It would instead always turn
the used lights off, no matter whether the option was enabled or not.

e |f you open a SuperStar sequence and it fails to open the associated audio file, the time layers
would be blank. This has been fixed to default to a five minute length.

e The Hardware Utility might have crashed if an error occurred while selecting a COM port.

e When importing a visualization in SuperStar, sometimes the morph selection points would
disappear, and the next time you used them, a spurious line would get drawn.

e The LOR Diagnostic utility was displaying incorrect information about the configured LOR
networks, and no information about configured DMX universes.

e [f the name of a DMX adapter began with a number, the Network Preferences program would list
its name right justified instead of left justified on the DMX tab.

e On some computers, various Light-O-Rama programs would refuse to run, saying that "Light-O-
Rama is not correctly installed", despite LOR having been installed.

e Undo and redo in SuperStar would sometimes not work properly; sometimes redo would not
restore all effects that had been undone, and sometimes undo or redo would cause SuperStar to
crash.

What's New in Version 3.9.0

e Comm speed changes

e Hardware Utility support for two networks in G3 MP3 Directors

e Hardware Utility support for 500K speed in G3 MP3 Directors

¢ Increased range of allowable sequencing grid lengths in imported visualizations
¢ New functions added in SuperStar dialogs

e Warning for channels needing a higher license level

e Verifier can be used on a single show or a single sequence
¢ New CCB/CCP firmware: Version 1.15

¢ New CCR firmware: Version 1.10
e New CTB32LG3/L OR160xWGS3 firmware: Version 1.08

© 2017 Light-O-Rama, Inc.



84

Light-O-Rama v5.0.14

e New CTB16PCGS3 firmware: Version 1.05
e New G3-MP3-Director Firmware: Version 5.22

e Bug fixes
Comm Speed Changes

Light-O-Rama networks were previously able to use communication speeds up to 115.4K. New
Generation 3 controllers, Cosmic Color Bulbs, Cosmic Color Ribbons, and Cosmic Color Pixels are
now able to support 500K, approximately four times faster. You can set your network to use 500K
in the LOR tab of the Network Preferences program. You may have to update your firmware to take
advantage of this new feature.

Also, network speeds are no longer referred to as distances. Instead, the actual speed of the
connection is used. "Long Range" is now called "19.2K", "Awverage" is now "57.6K", and "Short
Range" is now "115.4K".

Hardware Utility Support for Two Networks in G3 MP3 Directors

Previously, a Light-O-Rama MP3 Director was able to control a show on a single LOR network. The
new Generation 3 MP3 Directors are able to control two separate networks, and the Hardware Utility
has been updated to support this new functionality.

Hardware Utility Support for 500K Speed in G3 MP3 Directors

Previously, a Light-O-Rama MP3 Director was able to support communications speeds up to
115.4K. The new Generation 3 MP3 Directors are able to additionally support 500K, approximately
four times as fast as earlier controllers. The Hardware Utility has been updated to support this new
functionality. You may hawe to update your firmware to take advantage of this new feature.

Increased Range of Allowable Sequencing Grid Lengths in Imported
Visualizations

When importing a visualization into SuperStar, you can now set the maximum sequencing grid
length anywhere from 25 to 200, rather than the previous 50 to 100.

New Functions Added in SuperStar Dialogs

Various new functions were added to some of SuperStar's dialog boxes: "Mowve pixels" was added in
the scene group modify dialog box; "Move endpoints" and "Rewerse direction" were added in the
morph group maodify dialog box; "Use Head Color" was added in the morph dialog box.

Warning for Channels Needing a Higher License Level

When opening a sequence in the Sequence Editor, a warning is presented if the sequence contains
channels that your license level cannot control. This warning appears only once per Sequence
Editor session.

Verifier Can Be Used on a Single Show or a Single Sequence

The Light-O-Rama Verifier, which can be used to check for various problems with your schedule,
shows, and sequences, used to check your schedule, the shows that are on that schedule, and the
sequences that are in those shows. It still can do that (and still does it by default), but now you can
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also ask it to check just a single show (regardless of whether it is scheduled or not), or a single
sequence (regardless of whether it is in a show or not).

Note, though, that it's possible that two sequences which each pass individual checks from the
Verifier without any problems might still have problems when used together within a single show. So
it's always a good idea to run the Verifier against their show, and especially against the entire
schedule, at least once before going live with your show.

New CCB/CCP Firmware: Version 1.15

This new firmware for Cosmic Color Bulbs and Cosmic Color Pixels supports 500K communications
speed.

New CCR Firmware: Version 1.10

This new firmware for Cosmic Color Ribbons supports 500K communications speed.

New CTB32LG3/LOR160xWG3 Firmware: Version 1.08
This new firmware for CTB32LG3/LOR160xWG3 has the following changes:

e Support for 500K communications speed.

e Support for LED Display sharing with the new G3-MP3-Director when the director is attached
rather than the regular Display Daughter Card.

¢ A bug was fixed in standalone mode when the unit is used as a director for other controllers while
running a standalone sequence.

New CTB16PCG3 Firmware: Version 1.05

This new firmware for CTB16PCG3 controllers supports 500K communications speed.

New G3-MP3-Director Firmware: Version 5.22

The G3-MP3-Director is a new device that will replace the DC-MP3.
Bug Fixes

¢ In SuperStar, a Mvisualization with a matrix of CCRs sometimes would not clip effects to stay within
the CCR matrix. This was especially noticeable when playing image actions on the CCR matrix.

¢ In SuperStar, if you saved an archive file, and then opened it, you could no longer export it with the
demo ersion.

¢ |f you did a Create QuickVis on a combination of CCR controllers and standard 16 channel
controllers, then SuperStar would place the first row of 16 channel controllers on top of the last
row of CCR controllers.

¢ In SuperStar, only the end points of RGB light strings (strings where all the lights are the same
RGB color) were being drawn. This has been fixed to draw bulbs along the entire string.

¢ When pressing the Play or Paste button in SuperStar, some unnecessary screen redraws were
done. These have been remowved.

¢ Selection of an RGB fixture was not working in SuperStar.

¢ |f you change from CCR mode to Vis mode, SuperStar will now automatically rename the file by
appending "_vis" to the end of the name. This is to prevent cases where you would otherwise lose
the star channels in a sequence that was done in CCR mode.
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If the Sequence Editor had hold of an audio file while SuperStar tried to create timings using that
audio file, SuperStar would crash.

If you are in "Full Range" color mode in SuperStar, and you set the color controls with the color
picker dialog box, red and green could be set to 130. This caused constant "integer out of range"
errors because the color fields in the dialog boxes had values out of range.

In the Animator, if the file that was supposed to be used as the background image of the
animation did not exist, the "Remove Image" button would be grayed out, thus giving no
straightforward way to remowe the reference to the image from the animation.

When trying to create a new musical sequence in the Sequence Editor, media files with the
extension "m4a" would not be shown unless the dropdown box controlling the types of media files
displayed was changed from "All Supported Files" to "MPEG Audio".

Added support for non-continuous lines in a light string in a visualization in SuperStar.

Added support for "superstar cool" and "superstar warm" to indicate the dimming curve to use in

SuperStar.
On a large resolution screen, you could have ended up with more than ten rows in the time layers

in SuperStar.

In SuperStar, if using an imported visualization using up and over CCRs, or wedge CCRs, images
got clipped to the first half of the sequencing rows.

One of the things that the Verifier checks is whether or not any LOR program files (such as the
Sequence Editor) are missing. There were a few such program files that it was not checking for.
SenvoDog controllers were not being properly detected by the Hardware Utility.

If an international character was used in the name of an audio file in SuperStar, and the sequence
was exported, the Sequence Editor would fail to open the sequence.

In some situations, a SuperStar sequence could be erased if you saved after clicking "New
Document".

A memory leak, which could affect any program using a sequence but which was most noticeable
in the Show Player during shows that were using non-compressed sequences, has been fixed.

In SuperStar, after a paste of a group of effects and nudging the pasted effects around, sometimes
a "group modify" would modify more than it should.

When changing configuration or layout information, SuperStar would crash if SSEdit.cfg was "read
only" (this would typically only happen if the Lightorama directory were placed in an area that the
operating system does not allow write access to). This has been fixed so that SuperStar will
instead display an error message advising that configuration and layout information could not be
saved.

What's New in Version 3.8.0

MA4A Support

Hiding Fixture/Prop Names

Default Channel Names Options
Protected Sequences on SD Cards
Bug Fixes

M4A Support

M4A media files are now supported in musical sequences.

Hiding Fixture/Prop Names

A new option has been added to hide fixture/prop names in the Visualizer when something is
selected in the editor. This can reduce editing screen clutter.
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Default Channel Name Options

When creating new channels on a fixture in the Visualizer, there are now options to default the
channel name to one or more of the Fixture Name, Channel Order Number, or RGB Color (if
applicable).

Protected Sequences on SD Cards

Protected sequences can now be used on SD cards via the Hardware Utility or the Simple Show
Builder.

Bug Fixes

e When upgrading to a new version of Light-O-Rama, existing SuperStar custom fonts would be
overwritten with those from the installer. Only the system fonts, not the custom fonts, should
have been overwritten (both should be installed if not already present).

e After double clicking a .LEE file in Windows, the Visualizer's toolbar icons were sometimes not
correctly enabled.

e Pressing Delete a second time while the Visualizer's "Are You Sure?" dialog was presented
caused a second "Are You Sure?" dialog to pop up. After responding to both of them, the
simulation data could be left in a corrupted state.

e |f you reduced the number of CCRs in a SuperStar sequence, saved, relaunched, and selected a
scene, the program would hang.

¢ In SuperStar's visualization mode, if you opened a sequence that uses an invalid visualization
path, the program would hang.

¢ In SuperStar, if a visualization had a matrix of CCRs, and some other CCRs as well, then image
actions could be seen on the other CCRs.

e [f there was more than one prop with CCRs in it, SuperStar would add them in the order found in
the Misualization. They are now sorted and added according to the row they are on.

What's New in Version 3.7.0

e Easier Visibility of Morph Paths
e Max Length of Sequencing Rows
e Wrap Around Mode

e Tree Wizard Improvements

¢ Performance of Creation of Standalone Sequences Improved
e Bug Fixes

Easier Visibility of Morph Paths

In SuperStar, a line is drawn from la-2a and 1b-2b for morph anchor points. This makes it easier to
see the path that the morph is going to take.

Max Length of Sequencing Rows

SuperStar now has a "Max Length" setting to set the length of sequencing rows from 50 to 200.
This allows the sequencing rows to be longer, so all fixtures on a row in a Misualization will fit on one
row.

Wrap Around Mode
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SuperStar now has a "wrap around mode", designed to be used with 360 degree trees to make it
easier to hawe an effect start and end in a particular place.

Tree Wizard Improvements

The Tree Wizard in the Visualizer has been streamlined. This includes a new option for a top radius,
and several new CCR bundle types.

Performance of Creation of Standalone Sequences Improved

The creation of standalone sequences (for example, in the Hardware Utility for an MP3 Director) has
been made significantly faster. For example, a certain very large sequence that used to take over
twenty minutes to convert to a standalone sequence on a certain computer now takes approximately
one minute on that same computer.

Bug Fixes

e |f SuperStar had never been run on a particular computer before, or its configuration had never
been changed, and you attempted to change the rotation on a new sequence (not on a sequence
loaded from a file), SuperStar would hang in certain cases.

e |f SuperStar had never been run on a particular computer before, or its configuration had never
been changed, and you attempted to bring up the Layout dialog box and change to half ribbons,
the text would be clipped so that only the first ribbons got text on them.

¢ In SuperStar's CCR mode, if you added white text, it would have a red shadow on it.

¢ When a Msualization was used in SuperStar, in some situations the file would be renamed to
_\is.sup.

¢ In SuperStar's visualization mode, if the "Star in Use" setting was "Yes", effects would get offset
by four rows.

¢ In SuperStar, if the regular network was not being used, but had unit IDs in the same range as an
Aux network that was being used, channels for those unit IDs would have incorrectly used the
regular network instead of the Aux network.

¢ In the Visualizer, after inserting a prop from a file, the prop/fixture buttons and/or the list of props/
fixtures shown on the main editing window could be wrong.

What's New in Version 3.6.0

¢ Vertical Mode in Import Visualization
e Bug fixes

Vertical Mode in Import Visualization

e SuperStar's Import Visualization dialog how has an optional "vertical mode" sequencing grid
orientation, which can be used to more easily deal with displays that are taller than they are wide
(such as a visualization of an RGB megatree).

Bug Fixes

¢ A bug in SuperStar was fixed related to the drawing of floods and bulbs in a visualization.

¢ Instant Sequence was producing white effects for CCRs, but not for RGB lights. It will now treat
strings of RGB lights the same as CCRs.

e SuperStar now supports reversing the order of fixtures in a prop if necessary in order to support a
matrix of RGB lights that are not a Cosmic Color Device.
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e Having an "&" character in a fixture or prop hame in a visualization exported to a sequence by
SuperStar sometimes caused an "unterminated entity" error when the exported sequence file was

opened in the Sequence Editor.

What's New in Version 3.5.0

e F1.31 supported

e New Network Configuration program

e Play efficiency improvements

e New "QuickVis" files in SuperStar

e Improved handling of half-ribbon matrix arrays in imported visualizations
e Maximum Detection Rows setting for imported visualizations

e Improved error reporting when importing visualizations

e Change to names of channels in exported visualizations

e Morphs across entire sequencing grid after importing visualization
e Can select individual pixels in CCR \isualization in SuperStar

e New mouse selection abilities in SuperStar visualizations

e Can select start and end points of morphs in SuperStar visualizations
e Start and end marks of morphs more easily identifiable

e Dimming curves in exported visualizations

e Support for duplicate fixtures in SuperStar visualization mode

e Improved Instant Sequence effects

¢ Improved balance across comm networks

e Arches with less than four segments

e Default grid color in Visualizer's options dialog

e Cancelling out of Visualizer's wizard to create fixtures

¢ Increase pointer precision in Visualizer by holding Shift

e Move only horizontally or vertically in Visualizer by holding Ctrl

e Suppress "Is this the port for shows" in the Hardware Utility

e "Color by time" in Instant Sequence

¢ Too-frequent SuperStar warning removed

e SuperStar group delete efficiency improved

e Bug fixes

E1.31 Supported

E1.31 protocol, also known as "streaming DMX over ACN", is now supported for DMX devices. This
allows native DMX devices to be hooked up to LOR over an ethernet network, rather than over a
serial port. Note that one or more E1.31 gateway devices, which convert E1.31 to standard DMX,
would be required between your computer and your DMX devices.

New Network Configuration Program
A new program, the Light-O-Rama Network Preferences program, has been made. This program
can be used to set up your various network settings, such as for your Light-O-Rama networks, DMX
universes, X10 network, and so on.
This new program replaces the Sequence Editor's Network Preferences dialog. It can be launched

through the Sequence Editor's Preferences menu, the Light-O-Rama Control Panel, or as a
standalone Windows program.

Play Efficiency Improvements
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Seweral efficiency improvements were made related to playing sequences, both at the startup of play
and during play itself. These would be most noticeable on very large sequences, or sequences
using many events on DMX channels.

New "Quick Vis" Files in SuperStar

SuperStar now has the ability to create "Quick Vis" files, which are simple visualizations, enabling
you to use SuperStar's Instant Sequence feature without actually having a "real" visualization.

Improved Handling of Half-Ribbon Matrix Arrays in Imported Visualizations
SuperStar's handling of half-ribbon matrix arrays in imported visualizations has been improved.
Maximum Detection Rows Setting for Imported Visualizations

SuperStar's imported visualizations feature now has a new "maximum detection rows" setting, which
enables you to control how many rows the lights from the Misualization will be imported into.

Improved Error Reporting when Importing Visualizations

SuperStar's error reporting has been improved in situations when an error occurs while importing a
visualization.

Change to Names of Channels in Exported Visualizations
When SuperStar would export a visualization sequence, the names of exported channels used to

just be the names of the visualization's channels. Now they are the visualization channel names
plus the visualization fixture names.

Morphs across Entire Sequencing Grid after Importing Visualization
After importing a visualization into SuperStar, the unused portion of a sequencing row is drawn in
dim green and is selectable. This makes it possible to apply only one morph across the entire
sequencing grid.

Can Select Individual Pixels in CCR Visualization in SuperStar
Individual pixels can now be selected in a CCR Msualization in SuperStar.

New Mouse Selection Abilities in SuperStar Visualizations
You can now select in SuperStar visualizations using Ctrl-left click and Ctrl-drag.

Can Select Start and End Points of Morphs in SuperStar Visualizations
You can now specify the start and end points of a morph in a visualization in Superstar.

Start and End Marks of Morphs More Easily Identifiable

The start and end marks of a morph in SuperStar are now cyan and magenta to help identify them.
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Formerly, they were both white.
Dimming Curves in Exported Visualizations

When exporting a visualization in SuperStar, an LED dimming curve is used for CCRs and RGB
devices, while an incandescent dimming curve is used for all other lights.

Support for Duplicate Fixtures in SuperStar Visualization Mode
SuperStar's visualization mode now supports duplicate fixtures.
Improved Instant Sequence Effects
The effects generated by SuperStar's Instant Sequence are now limited by the size of each

sequencing row. This improves Instant Sequence effects to make them a bit more in sync and a bit
less choppy.

Improved Balance across Comm Networks

The buffer size for writes to serial port devices has been increased, as has the associated timeout
value. These changes improve balance across communications networks.

Arches with Less than Four Segments
The Visualizer's Arch Wizard previously wanted four or more segments; otherwise the arch would
not actually look like much of an arch. It now appears more archlike even with less than four
segments.

Default Grid Color in Visualizer's Options Dialog
The Visualizer's Options dialog now supports the default grid color option.

Cancelling Out of Visualizer's Wizard to Create Fixtures

The Visualizer's dialog to create fixtures now has a cancel button, giving the user the opportunity to
cancel out of the process.

Increase Pointer Precision in Visualizer by Holding Shift

Holding the Shift key while moving the mouse in the Visualizer now reduces the cursor speed, thus
making more precise cursor movements easier.

Move Only Horizontally or Vertically in Visualizer by Holding Ctrl
Holding the Ctrl key while moving the mouse in the Visualizer will now limit cursor movement to

either horizontal or vertical, depending upon the basic direction the mouse was mowving at the start of
movement.

Suppress "Is this the port for shows?" in the Hardware Utility

When the user selects a different COM port in the "Manual Select” dropdown box of the Hardware
Utility, the system asks if the newly selected port was "the LOR Show Port". If "Yes" was selected,
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the Regular network was set to use that port. A "Don't show this again" option has been added to
that dialog, so that the user will not see it over and ower, if desired.

"Color by Time" in Instant Sequence

SuperStar's Instant Sequence feature now supports a "color by time" option, which enables you to
specify an absolute length of time (such as "four seconds") that it will take for effects in a theme to
change color.

Too-Frequent SuperStar Warning Removed

When creating a new Instant Sequence in SuperStar, it would often give a warning about not being
able to undo your action. This warning has been removed.

SuperStar Group Delete Efficiency Improved

SuperStar's group delete function has been optimized to be faster when deleting a large number of
effects.

Bug

Fixes

Lock and Unlock on the Visualizer's right-click context menu were not working correctly.

The Visualizer incorrectly allowed for multiple unselected fixture/prop deletes when using the DEL
key.

In SuperStar, shrinking a visualization to fit the screen would not always work correctly.

Various "import visualization" bugs were fixed in SuperStar.

If you imported a visualization in SuperStar, the first and last boxes on the first sequencing row
would be set to white, yet if you tried to add a scene, you would get an error saying that no pixels
were selected. This has been fixed so that no sequencing row boxes are selected after the import
of a visualization.

When the Light-O-Rama Control Panel launched another program (such as the Schedule Editor),
the program would start minimized.

When checking that the networks used by channels were configured, the Verifier would not check
if the network was a DMX universe.

The first effect in a SuperStar Instant Sequence would not start out at the right color.

When doing an Instant Sequence on a visualization using SuperStar's Color Wheel, and a row of
fixtures did not contain a color, there were cases where the row would not receive any \visible
effects for long periods of time.

In SuperStar's Import Visualization, there were cases where fixtures were not being recognized.

What's New in Version 3.4.0

SuperStar supports images and text when in visualization mode
Timing change in SuperStar's "forward" and "reverse"

Expanded WAV support in SuperStar

Visualizer can make itself shown in front of all other windows
SuperStar's export limit based on number of channels

Large visualizations shrunk to fit in SuperStar

Bug fixes

SuperStar Supports Images and Text when in Visualization Mode
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Images and text are supported in SuperStar while in Visualization mode. Note that it only makes
sense to use images in text in a visualization if you have a grid of lights. To use text, the grid must
be at least 5x5.

Timing Change in SuperStar's Forward and Reverse

When clicking on the Forward and Reverse buttons on the group of tape recorder buttons on
SuperStar's toolbar, it now scrolls forward or backward one second (it used to scroll two).

Expanded WAV Support in SuperStar

If the header in a WAV file is of an unknown format, SuperStar now uses default values to open the
WAV file. This is an unusual case, but it means that there are some WAV files that will now play
properly whereas they would fail to play previous to this change.

Visualizer Can Make Itself Shown in front of All Other Windows

A new option, "Force Simulation Window to Front", has been added to the Visualizer's Com/Ref
options tab (tab number 6). When this option is enabled, whenewer the Visualizer receives data and
is in Simulation mode, the Visualier window will force itself to be shown in front of all other windows.
This option is off by default.

SuperStar's Export Limit Based on Number of Channels

When in visualization mode, SuperStar now limits export based on the number of channels instead
of on the number of sequencing rows. For example, if you have a 2 CCR license, it will now allow
export of up to 300 channels when in visualization mode.

Large Visualizations Shrunk to Fitin SuperStar
If a visualization imported into SuperStar is too big, it is now shrunk to fit within the screen.
Bug Fixes

e [fin one of SuperStar's small views, sometimes the sequencing grid was too wide.

¢ |f a sequence were opened in one of SuperStar's small views, the numbers at the left of the time
layers wouldn't display properly.

e SuperStar's effect bar representing a scene for the star could have ended up being any color. This
has been fixed so that the bar is always white.

What's New in Version 3.3.0

Setting SuperStar's color control for images

Cosmic Color Bulb Support

Support for flipped Cosmic Color strings in Insert Device
Bug fixes

Setting SuperStar's Color Control for Images

When drawing an image in SuperStar, you can set the color of the color control to the color of an
image pixel by holding the Shift key and left-clicking the pixel with your mouse.
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Cosmic Color Bulb Support

Support for Cosmic Color Bulb devices has been added to the Sequence Editor's Insert Device
screen (in the Cosmic Color Device section) and to the Hardware Utility's CCR/CCB Configuration
screen.

Support for Flipped Cosmic Color Strings in Insert Device

Cosmic Color Devices hawve a hardware setting option where the pixel numbers can be "flipped” - i.e.
instead of pixel #1 being closest to the device and pixel #50 being furthest from it, pixel #50 is
closest and pixel #1 is farthest. The Sequence Editor's Insert Device screen's Cosmic Color Device
section now has an option to list RGB channels in the device being created from 1 to 50 or from 50
to 1, so as to more easily match up the sequence as shown on the screen with the actual hardware
device.

Bug Fixes

¢ In SuperStar, sometimes the length of an archive file would become five minutes instead of the
length of the original audio file.

¢ In the Visualizer, if the user pressed the Enter key on the Prop Properties screen, the last fixture
selected to be part of the prop may not have been saved correctly.

e When using the Visualizer's Prop Properties box, the system could occasionally throw a logged
error. The system correctly recovered, but the error should not have happened in the first place.

e When using the Visualizer's Channel Wizard on RGB props along with a reference file with RGB
channels, the second and subsequent fixtures assigned to the prop could have incorrect channel
assignments.

¢ In SuperStar, sometimes if you modified the image an an image action and then played the
sequence, it would hang.

e Some morphs in SuperStar could have had missing pixels.

What's New in Version 3.2.4

e Play startup speed improved in the Sequence Editor
e SuperStar filename changes

e SuperStar exported timing grid changed
e Bug fixes

Play Startup Speed Improved in the Sequence Editor

The amount of time that the Sequence Editor takes to start playing a sequence has been reduced
(this is most noticeable on very large sequences).

SuperStar Filename Changes

The names of various file types that SuperStar creates have been changed: Expott files are now

" sup.Ims" instead of ".sup.Ims"; vis files are "_vis.Ims" instead of ".\is.Ims"; archiwve files are
_archive.Ims" instead of ".archive.Ims". Also, exported files are named ".Ims" regardless of whether
they hawve an associated media file, with the expectation that the user will soon add a media file to
them.

SuperStar Exported Timing Grid Changed
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The timing grids of sequences exported from SuperStar have been changed from 0.10 seconds to
0.05 seconds.

Bug Fixes

¢ If you chose a color such as yellow-white in SuperStar's instant sequencing in CCR mode, you
would only see occasional yellow.

¢ In some cases, when "loop at end" was on and the play range started close to the end of the
seguence, play would not start properly in the Sequence Editor.

e On some Windows 7 computers, every time the Visualizer was started, it would ask the user if
they wanted to associate .LEE files to the program.

What's New in Version 3.2.0

¢ Running sequences displayed in LOR Control Panel

e New DMX adapter supported

e Simple Show Builder defaults to "All Files"

e SuperStar ".vis.sup" files

e SuperStar ".archive.sup"” files

e New option for creating trees in the Visualizer

e Effect type options for the tail of a morph in SuperStar

¢ Added group modify for scene effect type in SuperStar

e Updating Visualizer channels by name

e SuperStar supports DMX for visualizations

e SuperStar supports multiple networks for visualizations

e Visualizer from the command line

e Visualizer files registered with Windows

e Paste Multiple can paste to the end of a group

e Sequence Editor remembers the directory of the last sequence opened or saved
e Ending drawing via the keyboard

e Tooltips for channel group expander buttons

e Control Panel remembers whether schedule is enabled or not after shutting down
e Bug fixes

Running Sequences Displayed in LOR Control Panel

During a show, the LOR Control Panel's status window now shows information about the various
seguences that are running.

New DMX Adapter Supported

The LOR USB485-1SO is now officially supported for use as a DMX adapter. It should use the "Raw
DMX' protocol.

Simple Show Builder Defaults to "All Files"

When selecting the sequences to use in the Simple Show Builder, the user is given a choice of
which sequences should be displayed so as to be able to choose from: "16 Channels", "32
Channels", and "All Files". The first two are not really based upon the number of channels in the
sequence; rather, they are based on the name of the file (for example, if "16 Channels" is selected,
all files with "16" in their names are displayed).
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Previously, the default would be "16 Channels". Since many people make sequences without any
having "16" in their filenames, this would result in a blank list being displayed, often leading to
confusion as to why the Simple Show Builder was not listing the sequences. To prevent this, the
Simple Show Builder now defaults to "All Files" instead of "16 Channels".

SuperStar ".vis.sup" Files
If you load a SuperStar sequence file and then import a Msualization, the filename of the SuperStar
sequence file is changed to end with ".vis.sup” instead of ".sup”. For example, a SuperStar
sequence named "AwesomeSequence.sup” will be changed to "AwesomeSequence.\vis.sup” upon
importing a visualization.

SuperStar ".archive.sup"” Files
If a SuperStar sequence file's name ends with ".archive.sup”, SuperStar will not let you change the

file using "Sawe". Instead, it will prompt you to use "Sawve As". If you then use "Sawe As", it will
rename the file to not have "archive" in the name. This is to help prevent changing an archive file.

New Option for Creating Trees in the Visualizer

The Visualizer's Tree Wizard can now also create trees that start at the center pole and go to the
base. Previously, it could only create trees where the initial point was on the base.

Effect Type Options for the Tail of a Morph in SuperStar

When doing a morph in SuperStar, you can now do a shimmer or a twinkle on the tail of the morph.

Added Group Modify for Scene Effect Type in SuperStar

"Modify Effect Type" was added as a check box in SuperStar's Scene Group Modify dialog box.
Previously, you could set the effect type individually, but could not set it to a group.

Updating Visualizer Channels by Name
When using a reference file, the Visualizer now gives you the option to update channels based on
the channel's name or the channel's key. Previously, the only update available was "by key". Now
when updating by name, the Visualizer can update the Device, Network, Unit, Circuit, and Channel

Color to what was loaded in the reference file(s). Updating by name will help those people who
change the physical layout of their channels.

SuperStar Supports DMX for Visualizations

Previously, SuperStar supported only Light-O-Rama controllers for imported visualization files. DMX
is now also supported.

SuperStar Supports Multiple Networks for Visualizations

Previously, SuperStar supported only one network for imported visualization files. It now supports
multiple networks.

Visualizer from the Command Line
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The Visualizer can now accept filenames on the command line. If you specify a filename on the
command line, the Visualizer will attempt to load it, skipping the "On Startup..." option. Ifit is not
successful, the "On Startup..." option will be used.

Visualizer Files Registered with Windows

The Visualizer now registers the ".lee" filename extension with Windows, so if you double click a
.lee file in Windows, the Visualizer will start and load that file automatically.

Paste Multiple Can Paste to the End of a Group

When selecting the number of times to paste ertically, the Sequence Editor's Paste Multiple dialog
used to give a choice between pasting an explicit number of times (such as 3 or 7) and "Paste all
the way to the end of the sequence”, which would paste vertically as many times as it took to get to
the last channel in the track. It now also gives the option to paste to the end of any channel group
or groups that contain the first channel being pasted to.

Sequence Editor Remembers the Directory of the Last Sequence Opened or
Saved

When a sequence is opened or saved in the Sequence Editor, the Sequence Editor now remembers
the directory of the sequence, so that the next time a new sequence is saved, or the next time the
Existing Sequence tab of the New and Open dialog is used, it will default to that directory.

Ending Drawing via the Keyboard

Previously, the only way to end a drawing in the Visualizer's editing window was to double click.
You can now also end a drawing by pressing either the End key or the Enter key.

Tooltips for Channel Group Expander Buttons

In the Sequence Editor, if you hover your mouse over the expander button for a channel group (the
small "+" or "-" button to the left of a channel group button), a tooltip will pop up saying the name of
the channel group it is for, and whether left-clicking on the button will cause the group to expand or
collapse.

Control Panel Remembers Whether Schedule Is Enabled or Not After Shutting
Down

The LOR Control Panel has always had the ability to start up automatically upon the computer being
started (and the Windows user logged on), and if the schedule had been enabled when the computer
was shut down, it would automatically enable the schedule upon being started as well. However, if
the Control Panel were unloaded via "Unload Light-O-Rama", it would not automatically enable the
schedule upon being started again. Now, when it is started up, it enables the schedule or not based
on whether or not it was enabled the last time it had been running.

Bug Fixes

¢ In SuperStar, exported CCR sequences have the RGB values "balanced” so that the colors on the
actual CCRs match the colors on your computer screen (think of this as a color correction made
to the RGB values). This was being done when in CCR mode, but when in visualization mode,
exported CCRs were not having their RGB values balanced.
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A SuperStar scene that used the Twinkle effect did not show that effect on the computer screen
(note that the effect did happen on the actual CCRs themselves).

After selecting effects in SuperStar, Ctrl-C would not copy the effects that you had just selected.
If you created a SuperStar sequence in CCR mode using the star, and then imported a
visualization, the channels for the star did not appear on the sequencing grid, and made it
impossible to change the star channels.

If two different effects in SuperStar attempt to control a channel at the same time, SuperStar
throws out the shortest command. Howewer, this was not being done for the commands in an
exported sequence. The result was that sequences with overlapping channel commands played
back differently in SuperStar than they did from an exported sequence.

After using a wizard, the Visualizer would correctly show Prop mode. Howewer, pressing the
"Fixture" button on the main screen sometime did not correctly change into Eixture mode.
Pressing the "Default" button on the Visualizer's Tree Wizard could incorrectly set the number of
pixels per segment, which could then cause an error.

If you make a selection in SuperStar's star channel grid, selections in the CCR channel grid will
be cleared, and vice-versa. Previously, the existing selection would not be cleared, which could
lead to confusing effects.

In SuperStar, if you loaded a sequence with timings, and then loaded one without timings, the
timing map would get stuck in Imported Timings mode, and attempting to set the frequency
spectrum would not work.

If you loaded a channel configuration file as a reference in the Visualizer, and then chose to
update existing channels, the channel colors for matching virtual channels could be set
incorrectly.

When "Disable Shows Immediately" was done in the LOR Control Panel, the lights on pative DMX
universe devices would not be turned off.

If the Sequence Editor's "Channel Button Colors" setting were set to anything besides "None", the
color of the channel buttons' fonts would vary during play even if "Vary Color of Channel Button
Fonts" were turned off in the Play Preferences dialog.

The Sequence Editor's Edit menu's keyboard shortcut for Set Paste Mode was changed from M to
O, because M was already in use for Paste Multiple, which led to it being impossible to open the
Set Paste Mode menu via the keyboard.

After a "Disable Shows Immediately" was done in the LOR Control Panel, in some cases a
message would appear in the status log saying "tmNextAction_Timer Error: Object variable or
With block variable not set".

When selecting a show file to schedule in the Schedule Editor, the "file type" dropdown box of the
file browsing dialog would allow either "Show Files" (which was the default) or "All Files".
Selecting "All Files" would allow you to schedule some sort of file other than a show file, which
would not accomplish what you were hoping (since the Show Player only supports scheduled
shows, not any other sort of scheduled thing). The Schedule Editor now only allows you to
schedule shows.

If a track were hidden, and that track were selected from the Sequence Editor's track dropdown
list (in the Tracks and Timings toolbar), the track would become the active track (as it should), but
it would remain hidden and the display would not move to show it.

In SuperStar, if you imported a visualization file and picked a recent file to open such as
"Untitled.sup”, the program would advise that it changed the name to "Untitled.vis.sup". However,
if you do a Save As, the name would default to "Untitled.sup" instead of "Untitled.\vis.sup".

When exporting a file in SuperStar, if you typed in a name such as "MySequence", it would give
an error saying that the file name has to end in ".Ims" or ".las". This has been fixed so that the
appropriate file extension automatically gets appended to such a file name.

In SuperStar, an image that was moved a short distance would stay on the screen too long.

In SuperStar, if you added some macros, selected those macros, deleted them, and then tried to
undo the group delete, they would not get restored. Also, if you selected a group of effects that
include some macros and did a group delete, it would not always undo properly, and in some
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cases would cause SuperStar to crash.

e Sometimes when importing a visualization file that contained RGB fixtures into SuperStar, the
channels for that fixture were not red, green, and blue.

e The controller for the star in SuperStar was always being placed in the Regular network; it can
now be placed in any network.

e [fthe Visualizer attempted to load a file that previously existed but was now missing, the error
message presented was not clear. The error message now explicitly says that the file is missing,
rather than the generic "XML error".

e [f you deleted the currently displayed timing grid in the Sequence Editor, it would continue to be
displayed until you manually displayed another.

e When exporting a SuperStar sequence, if the name of the media file